


  

PC System Diagnostics
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Insert Title Here

Actions: 

1)      Install the CD-ROM software accompanying the CD-ROM drive.    Follow the instructions accompanying 
the software.

2)      Re-attempt accessing the CD-ROM drive.

Question: 

Can the CD-ROM be accessed after installing any CD-ROM software?
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Title

Actions: 

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician.

1)      Turn off the computer and unplug the power cables.

2)      Unplug any external CD-ROM cables.

3)      Remove the base unit cover.

      Photo: Removing cover   

4)      Reseat the CD-ROM controller card.

5)      Replace the base unit cover.

6)      Plug all external power and data cables that were unplugged in steps 1) and 2).

7)      Turn on the computer and make sure the POST completes successfully.

8)      Retest the CD-ROM drive by doing the following:

a)      Place a CD in the CD-ROM drive.

b)      Access a file located on the CD.

Question: 

Does the CD-ROM work after reseating the controller card?





.





[Node:1666] 



   

Reseat controller card.

Cause: 

The CD-ROM cannot be accessed because of an UNKNOWN hardware or software problem with the CD-
ROM.    The CD-ROM drive or controller card may be bad.

Solution: 

Refer this problem to a qualified computer technician.    A qualified computer technician should test both the 
CD-ROM drive and controller card independently (and possibly on another computer).    Call the vendor or 
manufacturer for technical assistance, and replace the drive or controller card if necessary.
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Volume too low; Increase volume slide bars in audio 
mixer.

Cause:

The volume on the slide bars in audio mixer are too low.

Solution:

Increase the volume slide bars in the audio mixer.

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Programs'.

3)      Select 'Accessories'.

4)      Select 'Multimedia'.

5)      Select 'Sound Recorder'.    (The 'Sound - Sound Recorder' dialog box appears.)

      Sound Recorder  

6)      Select the 'Edit' menu and select 'Audio Properties'.    (The 'Audio Properties' dialog box appears.)

      Audio Properties  
7)      Use the mouse button to click and hold down on the 'Playback' volume control slide bar.
8)      With the mouse, move the slide bar to the right to increase the volume.
9)      Release the mouse button when the volume is at a desired level.

10)      Choose 'OK'. 



  

Re-connect joystick to game port on sound card.

Actions:

Re-connect the joystick to the game port on the sound card.

1)      Turn the computer off.

2)      Locate the game port on the sound card.

NOTE: The game port on the sound card generally has a series of pins surrounded by a metal band. The 
sound card can be located by following speaker cables (if they are attached) back to it. 

3)      Plug the joystick cable in to the game port.



  

Calibrate joystick    .

Actions:

Calibrate the joystick:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Settings'.

3)      Select 'Control Panel'.

      Control Panel  

4)      Double click on the 'Joystick' icon.
5)      In the 'Joystick selection:' drop down list box, click the down arrow.    (A list of joysticks appears.)
6)      Select the type of joystick you have.

      Joystick screen  
7)      Choose the 'Calibrate' button.

      'Calibrate' button  .
8)      Follow the directions displayed to calibrate the joystick.
9)      When you have completed calibrating the joystick, choose 'OK'.



  

Check if game port enabled.

Actions:

Check if the game port is enabled:

1)    To determine if the problem is related to driver installation or a jumper setting, do the following:

a)      Choose the 'Start' button.

b)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

c)      Double-click the 'System' icon.

      'System' icon  .
e)      Choose the 'Device Manager' tab.

      'Device Manager' tab  
f)      Select the '+' symbol next to 'Sound, Video, and Game Controllers'.
Do one of the following:

1]    If    there is no 'Gameport Joystick' entry under 'Sound Video and Game Controllers', do the 
following:

a]      Double-click 'Add New Hardware' in the 'Control Panel' dialog box.

      Add New Hardware  

b]      To install a 'Gameport Joystick' driver, do the following:

1}      Choose the 'Next' button.

2}      Select the 'No' radio button and choose the 'Next' button.

3}      Select 'Sound, Video, and Game Controllers' from the 'Select the type of hardware you 
wish to install' list box.

4}      Select the 'Next' button.

5}      Select 'Microsoft' from the 'Manufacturers' list box.

6}      Select 'Gameport Joystick' from the 'Models' list box.

7}      Select the 'Next' button.

8}      Follow the 'Add New Hardware Wizard' prompts until the driver is installed.

2]      If there is a 'Gameport Joystick' entry under 'Sound Video and Game Controllers', then the 
problem is related to a jumper setting. Consult the sound card documentation regarding the proper 
jumper settings to enable the game port.



   

Does joystick connect to sound card or keyboard?

Actions:

Read the information that is included with the joystick to determine where the joystick should be connected.



  

Check configuration of game port.

Actions:

Check configuration of the game port:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Settings'.

3)      Select 'Control Panel'.

      Control Panel  

4)      Double click on the 'System' icon. (The 'System Properties' dialog box appears.)

      'System' icon  
5)      Choose the 'Device Manager' tab.
6)      Choose the 'Resources' tab.
7)      In the 'Conflicting device list' box, are there any conflicts?    If there are conflicting devices, skip to the 'If You 
Have Conflicting Devices' section.    If there are no conflicts, continue with the next step.

      Conflicting device list  
8)      Choose 'OK'.
9)      Choose 'OK'.

If You Have Conflicting Devices

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Settings'.

3)      Select 'Control Panel'.

      Control Panel  

4)      Double click on the 'System' icon.    (The 'System Properties' dialog box appears.)
5)      Choose the 'Device Manager' tab.
6)      Double click on    the 'Sound, Video and Game Controllers' icon.

      'Sound, Video and Game Controllers' icon  
7)      Double click on the sound card listed. 
8)      Choose the 'Resources' tab.
9)      Note under the 'Conflicting Device List' box if it indicates that there is any conflict with another device.

      Conflicting Device List  

10)      If yes, note the IRQ address that it is conflicting with.

11)      Select 'Cancel'.

12)      Make sure that 'Interrupt request (IRQ)' is selected.



13)      Double click on the 'Computer' icon.

14)  Check the list showing the IRQ number assigned to each device on your computer.

      IRQ number  

15)  Determine an IRQ number that is not being used by another device.

16)      Choose 'Cancel'.

17)      Double click on the sound card again.

18)      Choose the 'Resources' tab again.

19)      If    'Use automatic settings' is selected, unselect it.

      Use automatic settings  

20)      In the 'Resource Listings' box, double click on 'Interrupt Request'.

      Interrupt Request  
21)      In the 'Value' box, enter the IRQ number you wish to set for the sound card.

      Value  

22)      Choose 'OK' from each box until you return to the 'Control Panel'.



  

Re-connect joystick to game port on keyboard.

Actions:

Re-connect the joystick to the game port on the keyboard:

1)      Turn the computer off.

2)      Locate the game port on the keyboard.

NOTE: The game port on the keyboard generally has a series of pins surrounded by a metal band. The 
keyboard port can be located by following keyboard cable (if it is attached) back to it. 

3)      Plug the joystick cable in to the game port.



   

What type of connection to computer does scanner 
require?

Actions:

Read the information that is included with the scanner to determine the type of connection required.



   

Connect scanner to the serial port on computer.

Actions:

Connect scanner to the serial port on computer:

1)      Turn the computer off.

2)      Locate the serial port.

NOTE 1: Look at back of base unit for 9-pin or 25-pin connector slots. Most base units have ports mounted 
along the back left side of the unit.    Serial ports usually appear as a 9-pin male connection, often 
above/beside a 25-pin parallel port female socket (often connected to a printer). Serial ports are often 
labeled COM1 or COM2.

NOTE 2: Refer to the manufacturers manual if further assistance is required in locating the serial port.

3)      Connect the scanner cable to the serial port.



   

Connect scanner to the parallel port on computer.

Actions:

Connect scanner to the parallel port on computer:

1)      Turn the computer off.

2)      Locate the parallel port.

NOTE 1: Look at back of base unit for 9-pin or 25-pin connector slots. Most base units have ports mounted 
along the back left side of the unit.    Parallel ports usually appear as a 25-pin female socket (often 
connected to a printer pin male connection), often below/beside a 9-pin male serial port connection. 

NOTE 2:    Refer to the manufacturers manual if further assistance is required in locating the parallel port.

3)      Connect the scanner cable to the parallel port.



  

Does your computer have a SCSI interface card?

Actions:

Look at back of base unit for 50-pin connector slots.    The slots may be labeled SCSI in and SCSI out.    Refer to 
the computer manufacturer's manual if assistance is required in determining if you have a SCSI interface card.



  

Connect scanner to the SCSI card port on computer.

Actions:

Connect scanner to the SCSI card port on computer:

1)      Turn the computer off.

2)      Locate the SCSI card port.

NOTE 1: Look at back of base unit for 50-pin connector slots labeled SCSI in and SCSI out. 

NOTE 2:    Refer to the manufacturers manual if assistance is required in locating the SCSI card port.

3)      Connect the scanner cable to the SCSI card port.



  

Correct any configuration conflict.

Actions:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Settings'.

3)      Select 'Control Panel'.

      Control Panel  

4)      Double click on the 'System' icon. (The 'System Properties' dialog box appears.)

      'System' icon  
5)      Choose the 'Device Manager' tab.
6)      Locate the scanner.    It may be located in 'Other Devices'.

      Other Devices  
7)      Double click on the scanner listed. 
8)      Choose the 'Resources' tab.
9)      Note under the 'Conflicting Device List' box if it indicates that there is any conflict with another device.

      Conflicting Device List  

10)      If yes, note the IRQ address that it is conflicting with.

11)      Select 'Cancel'.

12)      Make sure that 'Interrupt request (IRQ)' is selected.

13)      Double click on the 'Computer' icon.

14)  Check the list showing the IRQ number assigned to each device on your computer.

      IRQ number assigned  

15)  Determine an IRQ number that is not being used by another device.

16)      Choose 'Cancel'.

17)      Double click on the scanner again.

18)      Choose the 'Resources' tab again.

19)      If    'Use automatic settings' is selected, unselect it.

      Use automatic settings  

20)      In the 'Resource Listings' box, double click on 'Interrupt Request'.

      Interrupt Request  
21)      In the 'Value' box, enter the IRQ number you wish to set for the scanner.

      'Value' box  

22)      Choose 'OK' from each box until you return to the 'Control Panel'.





  

Change to lower resolution on the image being 
scanned.

Actions:

Every scanner is different, therefore, consult your scanner user guide to determine how to change the resolution.

To give you general idea how to change the resolution of your scanner, below are instructions for the Hewlett 
Packard ScanJet 3c:

1)      Select the 'Custom' menu and select 'Print Path'.    (The 'Custom Print Path' dialog box appears.)

2)      Find your printer in the list box.    If you cannot find your printer in the list, skip to 'Changing resolution 
when printer is not listed'. 

3)      Select the printer.    (The dpi (dots per inch) appear in the 'Drawings and Halftones' and 'Photos' boxes.)

4)      Choose 'OK'.

Changing resolution when printer is not listed (Hewlett Packard ScanJet 3c):

1)      Select the 'Custom' menu and select 'Print Path'.    (The 'Custom Print Path' dialog box appears.)

2)      Determine the dpi (dots per inch) of your printer.    (Consult your printer manual to determine dpi.    Also, 
the printer have the dpi stamped on the printer.)

3)      Enter the horizontal dpi in the 'Horizontal' box under 'Drawings and Halftones'.

4)      Enter the vertical dpi in the 'Vertical' box under 'Drawings and Halftones'.

5)      Divide the horizontal dpi by 2 and enter that number in the 'Horizontal' box under 'Photos'.    For example, 
if the horizontal dpi of the printer is 300, enter 150 in the 'Horizontal' box under 'Photos'.

6)      Divide the vertical dpi by 2 and enter that number in the 'Vertical' box under 'Photos'.    For example, if the 
vertical dpi of the printer is 300, enter 150 in the 'Vertical' box under 'Photos'.

7)      Choose 'OK'



  

Turn up the volume dial on speakers.

Actions:

Turn the speaker volume up.

1)      Locate the volume control dial or knob on the speakers.

2)      Turn the speaker volume up.



   

Check sound mixer volume slide board.

Actions:

Check the volume level of the sound mixer board:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Programs'.

3)      Select 'Accessories'.

4)      Select 'Multimedia'.

5)      Select 'Volume Control'.    (The 'Master Out' or the 'Wave Input' dialog box appears.)

6)      If the 'Wave Input' dialog box appears, do the following:

a)      Select the 'Options' menu and select 'Properties'.

      Properties  

b)      Under 'Adjust volume for' select the 'Playback' radio button.
c)      In the 'Show the following volume controls:', make sure that there is a check in all of the check boxes.
d)      Choose 'OK'.    (The 'Master Out' box appears.)

      'Master Out' box  

7)      Use the mouse button to click and hold down on a volume control slide bar.

8)      With the mouse, move the slide bar up to increase the volume.

9)      Release the mouse button when the volume is at a desired level.

10)      Repeat steps 7) through 9) on all slide bars in the 'Master Out' dialog box.

NOTE: Make sure none of the 'Mute' check boxes have a check mark.

11)      When you have completed increasing the volume of all slide bars, select the 'Options' menu and select 
'Exit'.



  

Make sure speakers are getting power.

Actions:

Make sure that the speakers are getting power:

1)      Check the speakers' power cord and make sure it is plugged in properly.

2)      Turn on the speakers.

NOTE: If the speakers are still not receiving power after the power cord has been checked, properly 
plugged in and the speakers turned on, the problem may be a bad power cord. 



  

Check connection to jack on sound card.

Actions:

Check the connection to the jack that is located on the sound card:

1)      Locate the sound card speaker jack on the computer. 

NOTE: The sound card may have several different options which may make it confusing to locate.    The 
speaker jack generally looks similar to a headphone jack and may have a symbol over it that looks like 
sound waves coming from a half-circle.    If the computer has a modem, it may be part of the sound card.    If 
this is true, a phone cable will be plugged in to the sound card. 

2)      If the speakers are on, turn the off and carefully plug the speaker cable into the sound card speaker jack.

3)      Make sure that the speaker cable is plugged into the speakers and turn the speakers on.



  

Check installed sound drivers.

Actions:

Make sure that the installed sound drivers were installed properly.    If the install was incomplete or incorrect re-
install the sound drivers.

1)      Choose 'Start'.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click 'Add New Hardware'.

      Add New Hardware  
4)      To install or reinstall a new sound driver, do the following:

a)    Choose the 'Next' button.

b)      Select the 'No' radio button.

c)      Select the 'Sound, Video and Game Controllers' entry in the 'Hardware Types' list box.

      Hardware Types  

d)      Select the 'Next' button.
e)      To locate the type of sound card driver and install it, do the following:

1]      Select the manufacturer of the sound card in the 'Manufacturers' list box.

      Manufacturers  

NOTE: If unsure of the manufacturer, consult the sound card documentation. If there is no 
documentation, Creative Labs is a common manufacturer of sound cards. Many cards will operate 
using one of    the Creative Labs drivers.

2]      Select the sound card model from the 'Model Type' list box.

NOTE: Again, if unsure of the model type, consult the sound card documentation. If there is no 
sound card documentation, many sound cards will function if the 'Sound Blaster' driver is selected.

3]      Choose the 'Have Disk' button.

4]      Choose the 'Browse' button.

      Browse  

5]      Insert the disk with the sound card drivers in the appropriate drive.

NOTE: If the drivers are on a '3 1/2' diskette, appropriate drive will be the 'A:' drive. Many 
common drivers are also included with the 'Windows 95' software.

6]      Locate the folder where the appropriate drivers are located and select it.

7]      Choose 'OK'.

8]      Choose 'OK' in the 'Install from Disk' dialog box.

9]      Choose 'OK'.

10]      Choose the 'Finish' button.





  

Are speakers connected to CD-ROM instead of sound 
card?

Actions:

Are the speakers connected to the front of the base unit near where you put in a CD disc?

NOTE: The speakers should be connected to the back of the base unit.    Look for a speakers symbol on the back 
of the base unit.    Plug the speakers into that jack. 



  

Are Wave input volume slide bars pushed down or 
muted in Windows audio mixer?

Actions:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Programs'.

3)      Select 'Accessories'.

4)      Select 'Multimedia'.

5)      Select 'Volume Control'.    (The 'Master Out' or the 'Wave Input' dialog box appears.)

6)      If the 'Master Out' dialog box appears, do the following:

a)      Select the 'Options' menu and select 'Properties'.

      Properties  

b)      Under 'Adjust volume for' select the 'Recording' radio button.
c)      In the 'Show the following volume controls:', make sure that there is a check in all of the check boxes.
d)      Choose 'OK'.    (The 'Wave Input' box appears.)

      Wave Input  

7)      Use the mouse button to click and hold down on a volume control slide bar.

8)      With the mouse, move the slide bar up to increase the volume.

9)      Release the mouse button when the volume is at a desired level.

10)      Repeat steps 7) through 9) on all slide bars in the 'Wave Input' dialog box.

11)      When you have completed increasing the volume, select the 'Options' menu and select 'Exit'.



  

Make sure Windows Wave driver is installed.

Actions:

Make sure the Windows Wave driver is installed:

1)      Choose 'Start'.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click 'Add New Hardware'.

      Add New Hardware  
4)      To install or reinstall a new Wave driver, do the following:

a)    Choose the 'Next' button.

b)      Select the 'No' radio button.

c)      Select the 'Sound, Video and Game Controllers' entry in the 'Hardware Types' list box.

      Hardware Types  

d)      Select the 'Next' button.
e)      To locate the type of sound card driver and install it, do the following:

1]      Select the manufacturer of the sound card in the 'Manufacturers' list box.

      Manufacturers  

NOTE: If unsure of the manufacturer, consult the sound card documentation. If there is no 
documentation, Creative Labs is a common manufacturer of sound cards. Many cards will operate 
using one of    the Creative Labs drivers.

2]      Select the sound card model from the 'Model Type' list box.

NOTE: Again, if unsure of the model type, consult the sound card documentation. If there is no 
sound card documentation, many sound cards will function if the 'Sound Blaster' driver is selected.

3]      Choose the 'Have Disk' button.

4]      Choose the 'Browse' button.

      Browse  

5]      Insert the disk with the sound card drivers in the appropriate drive.

NOTE: If the drivers are on a '3 1/2' diskette, appropriate drive will be the 'A:' drive. Many 
common drivers are also included with the 'Windows 95' software.

6]      Locate the folder where the appropriate drivers are located and select it.

7]      Choose 'OK'.

8]      Choose 'OK' in the 'Install from Disk' dialog box.

9]      Choose 'OK'.

10]      Choose the 'Finish' button.





  

Make sure Windows MIDI driver is installed.

Actions:

Make sure the Windows MIDI driver is installed:

1)      Choose 'Start'.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click 'Add New Hardware'.

      Add New Hardware  
4)      To install or reinstall a new sound driver, do the following:

a)    Choose the 'Next' button.

b)      Select the 'No' radio button.

c)      Select the 'Sound, Video and Game Controllers' entry in the 'Hardware Types' list box.

      Hardware Types  

d)      Select the 'Next' button.
e)      To locate the type of sound card driver and install it, do the following:

1]      Select the manufacturer of the sound card in the 'Manufacturers' list box.

      Manufacturers  

NOTE: If unsure of the manufacturer, consult the sound card documentation. If there is no 
documentation, Creative Labs is a common manufacturer of sound cards. Many cards will operate 
using one of    the Creative Labs drivers.

2]      Select the sound card model from the 'Model Type' list box.

NOTE: Again, if unsure of the model type, consult the sound card documentation. If there is no 
sound card documentation, many sound cards will function if the 'Sound Blaster' driver is selected.

3]      Choose the 'Have Disk' button.

4]      Choose the 'Browse' button.

      Browse  

5]      Insert the disk with the sound card drivers in the appropriate drive.

NOTE: If the drivers are on a '3 1/2' diskette, appropriate drive will be the 'A:' drive. Many 
common drivers are also included with the 'Windows 95' software.

6]      Locate the folder where the appropriate drivers are located and select it.

7]      Choose 'OK'.

8]      Choose 'OK' in the 'Install from Disk' dialog box.

9]      Choose 'OK'.

10]      Choose the 'Finish' button.





  

Check if microphone plugged in securely to input jack.

Actions:

1)      Locate the microphone jack on the sound card.

NOTE: To locate the jack on the sound card, follow the speaker wires to the back of the base unit.    Near 
the speaker input plug, look for a microphone symbol or the letters 'mic'.    If further assistance is needed to 
locate the microphone input jack, consult your computer's user manual.

2)      Plug the microphone in the microphone jack.



  

Are microphone mixer settings set too low in Windows 
audio mixer?

Actions:

Change the volume level of the microphone mixer:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Programs'.

3)      Select 'Accessories'.

4)      Select 'Multimedia'.

5)      Select 'Sound Recorder'.    (The 'Sound - Sound Recorder' dialog box appears.)

      Sound Recorder  

6)      Select the 'Edit' menu and select 'Audio Properties'.    (The 'Audio Properties' dialog box appears.)

      'Audio Properties' dialog box  
7)      Use the mouse button to click and hold down on the 'Recording' volume control slide bar.
8)      With the mouse, move the slide bar to the right to increase the volume.
9)      Release the mouse button when the volume is at a desired level.

10)      Choose 'OK'.



  

Is DOS mixer set to a 0 (zero) volume?

Actions:

Consult the PC documentation to determine if you have a DOS mixer set.    If you do not have a DOS mixer set, 
answer this question 'No'.    If you do have a DOS mixer set, consult the documentation to determine how to 
increase the volume.



  

Is the programs' (game's) own mixer control set to 0 
(zero) volume?

Actions:

Because all games are setup differently, consult the application's documentation to determine how to increase 
the mixer control set. 



  

Is there an IRQ conflict between sound card and 
another device?

Actions:

Determine if there is an IRQ conflict:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Settings'.

3)      Select 'Control Panel'.

      Control Panel  

4)      Double click on the 'System' icon. (The 'System Properties' dialog box appears.)

      'System' icon  
5)      Choose the 'Device Manager' tab.
6)      Double click on    the 'Sound, Video and Game Controllers'.

      'Sound, Video and Game Controllers' icon  
7)      Double click on the sound card listed. 
8)      Choose the 'Resources' tab.
9)      Note under the 'Conflicting Device List' box if it indicates that there is any conflict with another device.

      Conflicting Device List  
10)      If yes, note the IRQ address that it is conflicting with.
11)      Select 'Cancel'.
12)      Make sure that 'Interrupt request (IRQ)' is selected.
13)      Double click on the 'Computer' icon.
14)      Check the list showing the IRQ number assigned to each device on your computer.

      IRQ number assigned   
15)      Determine an IRQ number that is not being used by another device.
16)      Choose 'Cancel'.

17)      Double click on the sound card again.

18)      Choose the 'Resources' tab again.

19)      If    'Use automatic settings' is selected, unselect it.

      Use automatic settings  

20)      In the 'Resource Listings' box, double click on 'Interrupt Request'.

      Interrupt Request  
21)      In the 'Value' box, enter the IRQ number you wish to set for the sound card.

      'Value' box  
22)      Choose 'OK' from each box until you return to the 'Control Panel'.





  

Check audio cable and speaker connections.

Actions:

Consult the PC and speaker documentation to determine if the speakers and cables were inserted into the correct 
jack.    Also verify that they are fully inserted.    If they are only partly inserted, the sound may be distorted in 
some way.



  

Re-install the correct sound driver.

Actions:

Ensure that the driver is not obsolete and is correct for this sound card.    If the sound card is not correct contact 
the retailer for further information.    If the sound card is correct, re-install the sound driver again.    Use the 
diskettes or CD that came with the sound driver and follow the instructions based on the sound card 
documentation.



  

Turn up the volume dial on speakers and sound card.

Actions:

To turn the speaker volume up, do the following:

1)      Locate the volume control on the speakers.

2)      Turn the speaker volume up.

To turn the sound card volume up, do the following:

1)      Locate the volume control on the sound card.

NOTE 1: This is located on the back of the base unit.    The sound card dial should be located near where 
the speakers are connected to the base unit.

NOTE 2: Not all sound cards have a dial.

2)      Turn the sound card volume up.



   

Increase volume in audio mixer.

Actions:

Increase the volume in the audio mixer:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Programs'.

3)      Select 'Accessories'.

4)      Select 'Multimedia'.

5)      Select 'Sound Recorder'.    (The 'Sound - Sound Recorder' dialog box appears.)

      'Sound - Sound Recorder' dialog box  

6)      Select the 'Edit' menu and select 'Audio Properties'.    (The 'Audio Properties' dialog box appears.)

      'Audio Properties' dialog box  
7)      Use the mouse button to click and hold down on the 'Playback' volume control slide bar.
8)      With the mouse, move the slide bar to the right to increase the volume.
9)      Release the mouse button when the volume is at a desired level.

10)      Choose 'OK'.



  

Replace speaker wire.

Actions:

Contact the computer manufacturer or go to a computer store to obtain a speaker wire that is compatible with 
your speakers and computer.    Consult the speakers' user manual for additional information. 



   

Adjust balance control on speaker.

Actions:

Adjust the balance control on the speakers:

1)      Locate the balance control on the speakers.

NOTE: Your speakers may not have this control.    If you do not have a balance control, answer 'No' to this 
question.

2)      Adjust the balance.



  

Adjust balance control in audio mixer.

Actions:

Adjust the balance control in the audio mixer:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Programs'.

3)      Select 'Accessories'.

4)      Select 'Multimedia'.

5)      Select 'Volume Control'.    (The 'Master Out' or the 'Wave Input' dialog box appears.)

6)      If the 'Wave Input' dialog box appears, do the following:

a)      Select the 'Options' menu and select 'Properties'.

      Properties  

b)      Under 'Adjust volume for' select the 'Playback' radio button.
c)      In the 'Show the following volume controls:', make sure that there is a check in all of the check boxes.
d)      Choose 'OK'.    (The 'Master Out' box appears.)

      'Master Out' box  

7)      Use the mouse button to click and hold down on a balance control slide bar.

8)      With the mouse, move the slide bar to the right to change the balance.

9)      Release the mouse button when the balance is at a desired level.

10)      Repeat steps 7) through 9) on all slide bars in the 'Master Out' dialog box.

11)      When you have completed increasing the volume of all slide bars, select the 'Options' menu and select 
'Exit'.



  

Make sure that speaker is connected to other speaker.

Actions:

The speakers not only have to be connected to the computer's base unit, but also to each other.    More than 
likely, of your two speakers, only one will have jacks that allow you to plug in other devices (the other speaker, 
a subwoofer, input into the base unit, and an jack for the power supply). Make sure that the speaker with no 
jacks is connected to the speaker with outlets.    The speaker should plug into the jack that is usually named 
'Speaker' or 'Left'.    Consult your speaker user documentation for specific information.



   

Replace speaker wire.

Actions:

Contact the computer manufacturer or go to a computer store to obtain a speaker wire that is compatible with 
your speakers and computer.    Consult the speakers' user manual for additional information. 



  

Are the modem connections to the telephone lines 
correct?

Actions:

Consult the documentation that came with your modem to determine:

1)      How many connection cords are necessary (1 or 2).

2)      If any adapters (to allow 2 lines to plug into the same jack) are needed.

3)      If the connection cords are connected to the correct jacks on the base unit, telephone wall jack or 
telephone.



  

Plug headphones into speaker jack on sound card to 
test the sound card.

Actions:

Plug the headphones into the speaker jack on the sound card:

1)      Obtain headphones that you would use with a walkman or connect to a stereo system.

2)      Take the speaker plug out of the speaker outlet on the back of the computer (base unit). (Remember where 
it came from.)

3)      Plug the headphones into the same outlet that the speakers were plugged into.



  

Is the correct printer selected in the page setup?

Actions:

The following instructions will not be the same in all applications, but will apply to most:

1)      Select the 'File' menu and select 'Print'.

      Print  

2)      In the 'Printer' box locate 'Name' or 'Type' of printer to see which printer is selected.

      Name  
3)      To change to another printer, select the arrow at the end of the box where the printer name is showing.    (A 
drop-down list of installed printers will be shown.)    Select the correct printer, then print your document again.



  

Are you printing through a Windows 95 application?

Actions:

Was the application (Word, PowerPoint, etc.) that you are trying to print from opened from Windows 95? 



  

What type of modem do you have?

Actions:

To determine the type of modem you have:

1)      Look at the back of the computer (base unit).

2)      Follow the phone line from the phone jack to the computer. 

3)      Determine where the phone leads: If the phone line goes directly into the back of the computer (base unit), 
you have an internal modem. If the phone line goes into a piece of computer hardware and then into the 
back of the base unit, you have an external modem.

External - An external modem is an additional piece of computer hardware that is connected to the back of the 
computer (base unit) to the COM (communications) port and then connected to the phone jack.

Internal - An internal modem is located inside the computer (base unit) and can not be seen until the cover of 
the base unit is lifted.    It is connected directly to the phone jack.



  

Determine UART chip speed.

Actions:

CAUTION: Installation of a chip within the computer should only be performed by a qualified computer 
technician. 

The 16550 chip is a standard in most IBM PS/2 and 386 computers, as well as practically all 486 and above 
based computers.

To determine the speed of the UART chip:

1)      Run a hardware status program (e.g., Microsoft Diagnostics (MSD) to identify port and interrupt (IRQ) 
assignments.    To run Microsoft Diagnostics, do the following:

a)      Open the 'Start' menu.

b)      Select 'Programs'.

c)      Select 'MS-DOS Prompt'.

d)      Enter the following at the MS-DOS prompt:

CD\

e)      Press ENTER.

f)      Enter the following at the C:> prompt:

C:\DOS\MSD

2)      Select 'Com Ports...' from MSD main screen. 

3)      Determine speed of UART chip at 'UART Chip Used'.



 

Are you using speakers from a stereo system?

Actions:

Have you attached speakers from a home stereo system to the computer?



  

Do you have a stereo sound card?

Actions:

Consult the documentation that came with your sound card to determine if it is a stereo card.    If the sound card 
is an 8-bit card, then the card is mono.    If the sound card is 16-bit or higher, the card is stereo.



  

Did you use a mono cable to attach the speaker to the 
sound card?

Actions:

Check the package the cable came in to determine if the cable you are using is mono.    The type of cable may 
also be printed on the cable itself.    Look for 'mono' or 'stereo' on the cable.



  

Will the stereo plug fit into the sound card?

Actions:

Try to plug the stereo plug into the sound card:

1)      Locate the sound card outlet on the back of the computer (base unit).

This outlet is where the speakers should be connected and should be denoted by an audio symbol.    Refer 
to your user manual for specific information.

2)      Gently try to insert the stereo plug into the sound card outlet.



  

Are you trying to play a standard audio CD?

Actions:

A standard audio CD is a music CD that can be played in a home stereo system.



  

Clean CD and retry.    Does it sound better?

Actions:

Clean the CD disc.    Handle CD by the edges to keep clean. Use only a CD cleaning kit to clean the CD.    
Cleaning by other methods may leave a film or scratch the CD.



  

Does your CD-ROM require an IDE controller?

Actions:

SCSI and IDE are the types of device controllers used.    Consult your CD-ROM user manuals to determine if 
you have an IDE type of CD-ROM.



  

Does the disk have the letters ED printed on it?

Actions:

Information concerning the type of diskette is usually located on the sliding metal cover that protects the data 
on the diskette. 



  

Are you using a monochrome monitor or laptop?

Actions:

Monochrome monitor - A monochrome monitor displays only black, white, and various shades of gray.    This 
type of monitor displays no color.

Laptop - A laptop is a portable, notebook size computer.



  

Remove the expansion card, clean out the dust, 
reinstall and retry .

Actions:

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician.

1)      Remove the base unit cover:

a)      Turn the power off on computer and all peripherals. 

b)      Switch the surge protector off and unplug the power cable from the wall socket. 

WARNING: Ensure all components are turned off and power cable is disconnected. 

c)      Pull the base unit out slightly so that the rear panel is accessible. 

d)      Carefully remove all cables from back of base unit. 

1]      Check each cable for screw or finger-screw connections. Unscrew connectors. 

2]      Note the location and orientation of each connector during removal. (If necessary, draw a wiring 
diagram or tag the end of each cable noting its destination. 

3]      Gently remove each cable. Do not force or bend connectors to avoid costly damage to the 
connector or pins. 

e)      Remove screws from the top and sides of the back edge of the base unit. Store them together in a safe 
location. 

f)      Grasp the cover along the sides with two hands. SLOWLY and GENTLY slide the cover forward and 
off. Set it aside. 

CAUTION: Watch carefully to ensure parts of cover DO NOT catch on power or ribbon cables inside 
the base unit. 

g)      Ground yourself by touching the metal base unit casing with a finger. 

2)      Remove the expansion card.

a)      Remove the screw from the top notch of the mounting bracket on the card. 

b)      Touch the chassis to ground any static and, grasping the expansion card by its edge, remove the card 
by pulling it straight out of the slot gently but firmly. Avoid side-to-side movements (circuit boards 
crack easily). 

c)      Place the card in a static-resistant envelope. 

d)      If not inserting a replacement card in this slot, replace the rear metal slot cover and secure it in place 
with a screw. 

3)      Clean out the dust:

a)      Obtain a can of dust blasting spray from a computer store.

b)      Read directions on can to remove dust.

c)      Clean the edge connector of expansion card with rubbing alcohol and a Q-tip.



4)      Install new expansion card: 

a)      Remove the expansion card from its box and the protective anti-static envelope. 

b)      Locate the jumpers or DIP switches on the card and lay the card down on the anti-static envelope with 
the jumpers/DIP switches in view. 

c)      Read the expansion card manual and identify which, if any, settings must be changed on the card for 
this particular computer. 

d)      Move Jumpers and/or Change DIP Switches, if necessary. 

e)      Identify a free expansion slot of proper size, and remove the rear metal slot cover. 

f)      Touch the chassis to ground any static and, grasping the expansion card by its edges, insert the bottom 
of the card (part with the gold-striped bars) into the free slot. Press down firmly until the card is 
completely seated (especially if it is an EISA card). Avoid side-to-side movements when positioning 
the card (circuit boards crack easily). 

g)      Insert the screw, previously removed from the rear metal slot cover, into the top notch of the 
mounting bracket on the card and the screw hole and tighten it securely. 

h)      If the expansion card attaches to another device, connect the two devices using the supplied ribbon 
cable. 

i)      Check the manual to verify connector orientation, and gently insert the cable connector into the card 
connection and the other device. 

5)      Install drivers and test new configuration: 

a)      Make sure no parts or tools remain in chassis. 

b)      Replace necessary cables (power, keyboard, video), and plug in the power cable. 

c)      Power up computer and related peripherals one at a time. 

d)      Install driver software for card from diskette that came with the card, following the installation/setup 
instructions in the card's manual. 

e)      Test application software that uses the drivers and expansion card to ensure proper configuration. 

f)      Replace base unit cover. 

g)      Create/update a System Rescue Diskette that includes copies of necessary drivers and the following 
system-specific files: 

DOS/Windows: AUTOEXEC.BAT, CONFIG.SYS, Windows .INI and .GRP files. 

OS/2: OS2.INI, OS2SYS.INI, AUOTEXEC.BAT (for DOS sessions), CONFIG.SYS (OS/2 version), 
STARTUP.CMD



  

Do you have more than one SCSI device?

Actions:

Do you have another scanner, a SCSI tape backup unit, SCSI hard drive, etc.

You can determine how many SCSI devices you have by doing one or both of the following:

1)      Determine number of SCSI devices through the computer's booting process:

a)      Shut down all open applications.

b)      Shut down Windows.

c)      Reboot the computer.

d)      While the computer is going through its setup procedures, the number of SCSI devices are detected.    
Look for the words 'SCSI devices'.    The last number shown while the computer is detecting SCSI 
devices is the number of SCSI devices you have.

2)      Determine number of SCSI devices through the utilities:

a)      Shut down all open applications.

b)      Shut down Windows.

c)      Reboot the computer.

d)      Consult your PC documentation to determine how to enter and use the disk utilities function.    
Usually CTRL and a function key is used to enter utilities during setup.    A utilities screen will show 
each SCSI device.



  

Are the pins in the keyboard bent?

Actions:

Look at the keyboard plug that connects to the base unit.    If one or some of the pins in the plug are off center, 
bent, or broken, the plug will not fit.



  

Reduce scanning resolution and color depth.

Actions:

Every scanner is different, therefore, consult your scanner user guide to determine how to change the resolution 
and color depth.

To give you general idea how to change the resolution and color depth of your scanner, below are instructions 
for the Hewlett Packard ScanJet 3c:

1)      Select the 'Custom' menu and select 'Print Path'.    (The 'Custom Print Path' dialog box appears.)

2)      To change the color depth, do the following:

a)      Select the 'Tools' menu and select 'Color Adjustment'.    (The 'Color Adjustment' box appears.)

b)      Under 'Saturation', click the left arrow to reduce the amount of color on the scanning image.

3)      To change the printer resolution, do the following:

a)      Find your printer in the list box.    If you cannot find your printer in the list, skip to 'Changing 
resolution when printer is not listed'. 

b)      Select the printer.    (The dpi (dots per inch) appear in the 'Drawings and Halftones' and 'Photos' 
boxes.)

c)      Choose 'OK'.

Changing resolution when printer is not listed (Hewlett Packard ScanJet 3c):

1)      Select the 'Custom' menu and select 'Print Path'.    (The 'Custom Print Path' dialog box appears.)

2)      Determine the dpi (dots per inch) of your printer.    (Consult your printer manual to determine dpi.    Also, 
the printer have the dpi stamped on the printer.)

3)      Enter the horizontal dpi in the 'Horizontal' box under 'Drawings and Halftones'.

4)      Enter the vertical dpi in the 'Vertical' box under 'Drawings and Halftones'.

5)      Divide the horizontal dpi by 2 and enter that number in the 'Horizontal' box under 'Photos'.    For example, 
if the horizontal dpi of the printer is 300, enter 150 in the 'Horizontal' box under 'Photos'.

6)      Divide the vertical dpi by 2 and enter that number in the 'Vertical' box under 'Photos'.    For example, if the 
vertical dpi of the printer is 300, enter 150 in the 'Vertical' box under 'Photos'.

7)      Choose 'OK'



  

Are you using a laser printer?

Actions:

Do one of the following to determine printer type:

1)      Consult the printer's user manual to determine if the printer is a laser printer.

2)      Go to the printer and see if it says 'Laser Printer' on the printer.    Most printers have the company name or 
logo, or the model number of the printer stamped on the printer.    There should also be a stamp of the type 
of printer it is (laser, inkjet, dot matrix). 



  

Simplify your document and try it again.

Actions:

Use only one or two fonts and/or remove graphics to simplify the document.

For example, to simplify a Microsoft Word document, do the following:

1)      To change the text font:

a)      Select the text to change. 

1]      Click the mouse button at beginning of the text to change.

2]      Drag the cursor to the end of the last word to change

3]      Release the mouse button.

b)      Select the 'Format' menu and select 'Font'.    (The 'Font' dialog box appears.)

      'Format' menu  

c)      Select the 'Font' tab.
d)      Select the font from the 'Font' list box.    Use the arrows on the side of the list box to see other fonts.

      Font  
e)      Choose the 'OK' button.

2)      To remove graphics from a Word document:

a)      Click on the graphic to be removed.

b)      Select the 'Edit' menu and select 'Clear'.

      Clear  



  

Decrease print density settings.

Actions:

All graphic applications and printers are different.    Please consult your application    and printer documentation 
for specific details.    Below are general instructions that will help you get started:

1)      Select the 'File' menu and select 'Print'. (The 'Print' dialog box appears.)

      Print  

2)      In the 'Name' drop down list box, make sure the correct color printer is selected.

      Name  
3)      Choose the 'Properties' button.
4)      Choose the 'Options' button.    (The 'Options' dialog box appears.)
5)      Look for 'Print Density' or 'Intensity' and decrease the intensity.
6)      Choose 'OK' until you reach the main 'Print' dialog box.
7)      Choose 'OK'.



  

Set page setup to print in gray scale.

Actions:

All graphic applications and printers are different.    Please consult your application    and printer documentation 
for specific details.    Below are general instructions that will help you get started:

1)      Select the 'File' menu and select 'Print'. (The 'Print' dialog box appears.)

      Print  

2)      In the 'Name' drop down list box, make sure the correct color printer is selected.

      Name  
3)      Choose the 'Properties' button.
4)      Select the 'Print in gray scale'.
5)      Choose 'OK'.
6)      Choose 'OK' again.



  

Plug headphones into sound card.

Actions:

1)      Obtain headphones that you would use with a walkman or connect to a stereo system.

2)      Take the speaker plug out of the speaker outlet on the back of the computer (base unit). (Remember where 
it came from.)

3)      Plug the headphones into the same outlet that the speakers were plugged into.



  

Add terminator to scanner.

Actions:

Terminate the SCSI cable properly.

1)      Locate the middle connector in the SCSI cable.

2)      Plug the scanner into the middle connector.

3)      Take a terminator plug and place it at either end of the SCSI cable.



  

Change setup of mouse button to single-click.
.

Actions:

1)      Open the software program that came with the mouse and was installed when the mouse was installed.

2)      Check for an option that allows the mouse buttons to be programmed to certain functions.

3)      Change that option from 'Double-click' to 'Single-click.' 



   

Usually indicates hardware problem; Contact 
computer manufacturer.

Cause:

The reason the computer is beeping is unknown.

Solution:

Some problems usually associated with specific patterns of beeps or continuous beeping are:

Bad chip in computer

CMOS or BIOS damaged or bad

Bad board or card

Bad keyboard

Refer the problem to the manufacturer or contact a licensed service center.



  

Joystick not calibrated; Calibrate joystick before each 
game or session.

Cause: 

Joystick not calibrated

Solution:

Calibrating the joystick:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Settings'.

3)      Select 'Control Panel'.

      Control Panel  

4)      Double click on the 'Joystick' icon.

      'Joystick' icon  
5)      In the 'Joystick selection' drop down list box, click the down arrow.    (A list of joysticks appears.)

      Joystick selection:  
6)      Select the type of joystick you have.
7)      Choose the 'Calibrate' button.

      'Calibrate' button  
8)      Follow the directions displayed to calibrate the joystick.
9)      When you have completed calibrating the joystick, choose 'OK'.



  

Joystick connection wrong; Connect joystick to game 
port on sound card.

Cause:

The joystick is not connected to the game port on the sound card.

Solution:

Connect the joystick to the game port on the sound card.

1)      Turn the computer off.

2)      Locate the game port on the sound card, on the back of the computer.

NOTE: The game port on the sound card generally has a series of pins surrounded by a metal band. The 
sound card can be located by following speaker cables (if they are attached) back to it. 

3)      Plug the joystick cable in to the game port.



   

Joystick connection wrong; Connect joystick to game 
port on sound card.

Cause:

The joystick does not work because the game port on the sound card is not enabled on a hardware or software 
level.

Solution:

Enable the joystick by installing the game port driver or setting the game port jumpers.

To determine if the problem is related to driver installation or a jumper setting, do the following:

1) Choose the 'Start' button.

2) Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click the 'System' icon.

      'System' icon  

4)      Choose the 'Device Manager' tab.
5)      Select the '+' symbol next to 'Sound, Video and Game Controllers'.

      Sound, Video, and Game Controllers  

Do one of the following:

a)    If    there is no 'Gameport Joystick' entry under 'Sound Video and Game Controllers', do the following:

1]      Double-click 'Add New Hardware' in the 'Control Panel' dialog box.

      Add New Hardware  

2]      To install a 'Gameport Joystick' driver, do the following:

a]      Choose the 'Next' button.

b]      Select the 'No' radio button and choose the 'Next' button.

c]     Select 'Sound, Video and Game Controllers' from the 'Select the type of hardware you wish to 
install' list box.

      Sound, Video and Game Controllers  

d]     Select the 'Next' button.
e]     Select 'Microsoft' from the 'Manufacturers' list box.

      Manufacturers  
f]     Select 'Gameport Joystick' from the 'Models' list box.
g]     Select the 'Next' button.



h]     Follow the 'Add New Hardware Wizard' prompts until the driver is installed.
i]      If there is a ' Gameport Joystick' entry under '    Sound Video and Game Controllers', then the problem is related 
to a jumper setting. Consult the sound card documentation regarding the proper jumper settings to enable the game 
port.



  

Joystick connection wrong; Connect joystick to game 
port on keyboard.

Cause:

The joystick is not connected to the game port on the keyboard.

Solution:

Connect the joystick to the game port on the keyboard.

1)      Turn the computer off.

2)      Locate the game port on the keyboard.

NOTE: The game port on the keyboard generally appears like a plug with a series of pins in it. The plug 
will usually be found on the edge or bottom of the keyboard. 

3)      Plug the joystick cable in to the keyboard.



  

Joystick not setup; Connect joystick to sound card 
game port and calibrate.

Cause:

The joystick is not connected to the game port on the sound card and not calibrated.

Solution:

Connect the joystick to the game port on the sound card and calibrate.

Connecting joystick to sound card:

1)      Turn the computer off.

2)      Locate the game port on the sound card, on the back of the computer.

NOTE: The game port on the sound card generally has a series of pins surrounded by a metal band. The 
sound card can be located by following speaker cables (if they are attached) back to it. 

3)      Plug the joystick cable in to the game port.

Calibrating the joystick:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Settings'.

3)      Select 'Control Panel'.

      Control Panel  

4)      Double click on the 'Joystick' icon.

      'Joystick' icon  
5)      In the 'Joystick selection' drop down list box, click the down arrow.    (A list of joysticks appears.)

      Joystick selection:  
6)      Select the type of joystick you have.
7)      Choose the 'Calibrate' button.

      'Calibrate' button  
8)      Follow the directions displayed to calibrate the joystick.
9)      When you have completed calibrating the joystick, choose 'OK'.



  

Joystick not setup; Connect joystick to keyboard game 
port and calibrate.

Cause:

The joystick is not connected to the game port on the keyboard.

Solution:

Connect the joystick to the game port on the keyboard and calibrate.

Connecting the joystick to keyboard

1)      Turn the computer off.

2)      Locate the game port on the keyboard.

NOTE: The game port on the keyboard generally appears like a plug with a series of pins in it. The plug 
will usually be found on the edge or bottom of the keyboard. 

3)      Plug the joystick cable in to the keyboard.

Calibrating the joystick:

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Settings'.

3)      Select 'Control Panel'.

      Control Panel  

4)      Double click on the 'Joystick' icon.

      'Joystick' icon  
5)      In the 'Joystick selection' drop down list box, click the down arrow.    (A list of joysticks appears.)

      Joystick selection:  
6)      Select the type of joystick you have.
7)      Choose the 'Calibrate' button.

      'Calibrate' button  
8)      Follow the directions displayed to calibrate the joystick.
9)      When you have completed calibrating the joystick, choose 'OK'.



  

Serial scanner connection; Connect to correct serial 
port on computer.

Cause:

The scanner is not working because it is not connected to the serial port.

Solution:

Connect the scanner to the serial port.

1)      Turn the computer off.

2)      Locate the serial port on the back of the computer.

NOTE:    The serial port is usually a smaller port with only 9 pins inside of it. Refer to the manufacturers 
manual if assistance is required in locating the serial port.

3)      Connect the scanner cable to the serial port.



  

Parallel scanner connection; Connect to correct 
parallel port on computer.

Cause:

The scanner is not working because it is not connected to the parallel port.

Solution:

Connect the scanner to the parallel port.

1)      Turn the computer off.

2)      Locate the parallel port.

NOTE:    The parallel port is usually a larger outlet with small openings for 25 pins inside it.    Refer to the 
manufacturers manual if assistance is required in locating the parallel port.

3)      Connect the scanner cable to the parallel port.



  

SCSI scanner connection; Connect to SCSI card port 
on computer.

Cause:

The scanner is not working because it is not connected to the SCSI card port.

Solution:

Connect the scanner to the SCSI card port.

1)      Turn the computer off.

2)      Locate the SCSI card port.

NOTE:    Refer to the manufacturers manual if assistance is required in locating the SCSI card port.

3)      Connect the scanner cable to the SCSI card port.



   

No SCSI card; Obtain a SCSI adapter card and install 
in computer.

Cause:

The scanner does not work because there is no SCSI interface card in the computer.

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician. Installation of hardware by an individual without proper training and licenses may 
inadvertently damage equipment or invalidate warranties.

Solution:

A SCSI interface card is required. Install the SCSI interface card per the manufacturer's instructions.



  

Configuration conflict; Correct serial scanner 
configuration conflict.

Cause:

The serial scanner does not work because there is a configuration conflict.

Solution:

Change the serial scanner configuration.

1)      Choose the 'Start' button.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click the 'System' icon.

      'System' icon  
4)      Choose the 'Device Manager' tab.
5)      Double click on 'Ports (COM & LPT)'.

      Ports (COM & LPT)  
6)      Double click on the COM 1 port listed .
7)      Choose the 'Resources' tab.
8)      Note under the 'Conflicting Device List' box if it indicates that there is any conflict with another device.

      'Conflicting Device List' box  
9)      If yes, note the IRQ address that it is conflicting with.

10)      Select 'Cancel'.

11)      Make sure that 'Interrupt request (IRQ)' is selected.

12)      Double click on 'Computer'.

      Computer  

13)      Check the list showing the IRQ number assigned to each device on your computer.

      IRQ number assigned   

14)      Determine an IRQ number that is not being used by another device.

15)      Select 'Cancel'.

16)      Double click on the COM1 port again.

17)      Choose the 'Resources' tab again.

18)      If    'Use automatic settings' is selected, unselect it.



      Use automatic settings  

19)      In the 'Resource Listings' box, double click on 'Interrupt Request'.

      Interrupt Request  
20)      In the 'Value' box, enter the IRQ number you wish to set for the sound card.

      'Value' box  

21)      Choose 'OK' from each    dialog box until you return to the 'Control Panel'.



  

Configuration conflict; Correct parallel scanner 
configuration conflict.

Cause:

The parallel scanner does not work because there is a configuration conflict.

Solution:

Change the parallel scanner configuration.

1)      Choose the    'Start' button.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click the 'System' icon.

      'System' icon  
4)      Choose the 'Device Manager' tab.
5)      Double click on 'Ports (COM & LPT)'.

      Ports (COM & LPT)  
6)      Double click on the LPT1 port listed .
7)      Choose the 'Resources' tab.

Note under the 'Conflicting Device List' box if it indicates that there is any conflict with another device.

      Conflicting Device List  

If yes, note the IRQ address that it is conflicting with.

8)      Select 'Cancel'.

9)      Make sure that 'Interrupt request (IRQ)' is selected.

10)      Double click on 'Computer'.

      Computer  

11)      Check the list showing the IRQ number assigned to each device on your computer.    Determine an IRQ 
number that is not being used by another device.

      IRQ number assigned  
12)      Select 'Cancel'.
13)      Double click on the LPT1 port again.
14)      Choose the 'Resources' tab again.
15)      If    'Use automatic settings' is selected, unselect it.

      Use automatic settings   
16)      In the 'Resource Listings' box, double click on 'Interrupt Request'.



      Interrupt Request  
17)      In the 'Value' box, enter the IRQ number you wish to set for the sound card.    Choose 'OK' from each    dialog 
box until you return to the 'Control Panel.

      'Value' box  



  

Configuration conflict; Correct SCSI configuration 
conflict.

Cause:

The SCSI scanner does not work because there is a configuration conflict.

Solution:

Change the SCSI scanner configuration.

1)      Choose the    'Start' button.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click the 'System' icon.

      'System' icon  .
4)      Choose the 'Device Manager' tab.
5)      Double click on 'SCSI Devices'.
6)      Double click on the SCSI adapter card listed .
7)      Choose the 'Resources' tab.
8)      Note under the 'Conflicting Device List' box if it indicates that there is any conflict with another device.

      Conflicting Device List  

If yes, note the IRQ address that it is conflicting with.

9)      Select 'Cancel'.

10)      Make sure that 'Interrupt request (IRQ)' is selected.

11)      Double click on 'Computer'.

      Computer  

12)      Check the list showing the IRQ number assigned to each device on your computer.    Determine an IRQ 
number that is not being used by another device.

      IRQ number assigned  
13)      Select 'Cancel'.
14)      Double click on the SCSI adapter card again.
15)      Choose the 'Resources' tab again.
16)      If    'Use automatic settings' is selected, unselect it.

      Use automatic settings  
17)      In the 'Resource Listings' box, double click on 'Interrupt Request'.

      Interrupt Request  
18)      In the 'Value' box, enter the IRQ number you wish to set for the sound card.



      'Value' box  
19)      Choose 'OK' from each    dialog box until you return to the 'Control Panel'.



  

SCSI scanner may be defective; Contact 
manufacturer.

Cause: 

Scanner may be defective

Solution: 

Contact manufacturer or place of purchase.



  

Parallel scanner possibly defective; Contact 
manufacturer.

Cause: 

Scanner may be defective

Solution: 

Contact manufacturer or place of purchase.



  

Serial scanner possibly defective; Contact 
manufacturer.

Cause: 

Scanner may be defective

Solution: 

Contact manufacturer or place of purchase.



  

Determine type of scanner and connect to appropriate 
port.

Cause: 

Type of scanner is unknown

Solution: 

Refer to documentation that accompanied the scanner to determine the type of connection necessary.    If unable 
to determine, contact manufacturer or place of purchase.



  

Slow performance; Lower the resolution of image 
being scanned.

Cause:

The scanner is working very slowly because the resolution is set too high.

Solution:

Every scanner is different, therefore, consult your scanner user guide to determine how to change the resolution.

To give you general idea how to change the resolution of your scanner, below are instructions for the Hewlett 
Packard ScanJet 3c:

1)      Select the 'Custom' menu and select 'Print Path'.    (The 'Custom Print Path' dialog box appears.)

2)      Find your printer in the list box.    If you cannot find your printer in the list, skip to 'Changing resolution 
when printer is not listed'. 

3)      Select the printer.    (The dpi (dots per inch) appear in the 'Drawings and Halftones' and 'Photos' boxes.)

4)      Choose 'OK'.

Changing resolution when printer is not listed (Hewlett Packard ScanJet 3c):

1)      Select the 'Custom' menu and select 'Print Path'.    (The 'Custom Print Path' dialog box appears.)

2)      Determine the dpi (dots per inch) of your printer.    (Consult your printer manual to determine dpi.    Also, 
the printer have the dpi stamped on the printer.)

3)      Enter the horizontal dpi in the 'Horizontal' box under 'Drawings and Halftones'.

4)      Enter the vertical dpi in the 'Vertical' box under 'Drawings and Halftones'.

5)      Divide the horizontal dpi by 2 and enter that number in the 'Horizontal' box under 'Photos'.    For example, 
if the horizontal dpi of the printer is 300, enter 150 in the 'Horizontal' box under 'Photos'.

6)      Divide the vertical dpi by 2 and enter that number in the 'Vertical' box under 'Photos'.    For example, if the 
vertical dpi of the printer is 300, enter 150 in the 'Vertical' box under 'Photos'.

7)      Choose 'OK'



  

Mouse setup; Change setup of button so that it does 
not double-click.

Cause: 

Mouse button is programmed to double-click.

Solution:

1)      Open the software program that came with the mouse and was installed when the mouse was installed.

2)      Check for an option that allows the mouse buttons to be programmed to certain functions.

3)      Change that option from 'Double-click' to 'Single-click.' 



  

Volume on speakers/headphones turned down too low; 
Increase speaker volume.

Cause:

No sound is coming from the speakers because the volume is turned down too low.

Solution:

Turn the speaker volume up.

1)      Locate the volume control on the speakers.

2)      Turn the speaker volume up.



   

Volume down in sound mixer; Slide up volume slider 
bars to increase volume.

Cause:

No sound is coming from the speakers because the volume sliders    in mixer pushed down too far.

Solution:

Slide up volume slider bars to increase volume.

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Programs'.

3)      Select 'Accessories'.

4)      Select 'Multimedia'.

5)      Select 'Sound Recorder'.    (The 'Sound - Sound Recorder' dialog box appears.)

      'Sound - Sound Recorder' dialog box  

6)      Select the 'Edit' menu and select 'Audio Properties'.    (The 'Audio Properties' dialog box appears.)

      'Audio Properties' dialog box  
7)      Use the mouse button to click and hold down on the 'Playback' volume control slide bar.
8)      With the mouse, move the slide bar to the right to increase the volume.
9)      Release the mouse button when the volume is at a desired level.
10)      Choose 'OK'.



  

Speakers getting power; Check power cords and that 
power switch is on.

Cause:

There is no sound coming from the speakers because the speakers are not receiving power.

Solution:

Check the speakers' power cord to make sure it is plugged in properly and turn the speakers on.

1)      Check the speakers' power cord and make sure it is plugged in properly.

2)      Turn on the speakers.

NOTE: If the speakers are still not receiving power after the power cord has been checked, properly 
plugged in and the speakers turned on, the problem may be a bad power cord. 



   

Sound card connection; Connect speakers to output 
jack on sound card.

Cause: 

Speakers not connected to the sound card.

Solution:

Connect jack on speaker wires to the output jack on the sound card located at the back of the computer base 
unit.



  

Possible defective speakers or sound card; Contact 
manufacturer.

Cause:

There is no sound coming from the speakers because the sound card may be defective.

Solution:

Contact the manufacturer of the sound card or the place where sound card was purchased.



  

MIDI driver not installed; Install Windows MIDI 
driver.

Cause:

There is no sound coming from the speakers because the MIDI drivers are not installed or are corrupted.

Solution:

Install or reinstall the MIDI drivers.

1)      Choose 'Start'.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click 'Add New Hardware'.

      Add New Hardware  
4)      To install or reinstall a new sound driver, do the following:

a)    Choose the 'Next' button.

b)      Select the 'No' button.

c)      Choose the 'Next' button

d)      Select the 'Sound, Video and Game Controllers' entry in the 'Hardware Types' list box.

      Sound, Video and Game Controllers  

e)      Select the 'Next' button.
f)      To locate the type of sound card driver and install it, do the following:

1]      Select the manufacturer of the sound card in the 'Manufacturers' list box.

      Manufacturers  

NOTE: If unsure of the manufacturer, consult the sound card documentation. If there is no 
documentation, Creative Labs is a common manufacturer of sound cards. Many cards will operate 
using one of    the Creative Labs drivers.

2]      Select the sound card model from the 'Model Type' list box.

NOTE: Again, if unsure of the model type, consult the sound card documentation. If there is no 
sound card documentation, many sound cards will function if the 'Sound Blaster' driver is selected.

3]      Choose the 'Have Disk' button.

4]      Choose the 'Browse' button.

5]      Insert the disk with the sound card drivers in the appropriate drive.

NOTE: If the drivers are on a '3 1/2' diskette, the appropriate drive will be the 'A:' drive. Many 
common drivers are also included with the 'Windows 95' software.



6]      Locate the folder where the appropriate drivers are located and select it.

7]      Choose 'OK'.

8]      Choose 'OK' in the 'Install from Disk' dialog box.

9]      Choose 'OK'.

10]      Choose the 'Finish' button.



  

Windows Wave driver not installed; Install Windows 
Wave driver.

Cause:

There is no sound coming from the speakers because the Wave drivers are not installed or are corrupted.

Solution:

Install or reinstall the Wave drivers.

1)      Choose 'Start'.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click 'Add New Hardware'.

      Add New Hardware  
4)      To install or reinstall a new Wave driver, do the following:

a)    Choose the 'Next' button.

b)      Select the 'No' button.

c)      Choose the 'Next' button.

d)      Select the 'Sound, Video and Game Controllers' entry in the 'Hardware Types' list box.

      Sound, Video and Game Controllers  

e)      Select the 'Next' button.
f)      To locate the type of sound card driver and install it, do the following:

1]      Select the manufacturer of the sound card in the 'Manufacturers' list box.

      Manufacturers  

NOTE: If unsure of the manufacturer, consult the sound card documentation. If there is no 
documentation, Creative Labs is a common manufacturer of sound cards. Many cards will operate 
using one of    the Creative Labs drivers.

2]      Select the sound card model from the 'Model Type' list box.

NOTE: Again, if unsure of the model type, consult the sound card documentation. If there is no 
sound card documentation, many sound cards will function if the 'Sound Blaster' driver is selected.

3]      Choose the 'Have Disk' button.

4]      Choose the 'Browse' button.

5]      Insert the disk with the sound card drivers in the appropriate drive.

NOTE: If the drivers are on a '3 1/2' diskette, the appropriate drive will be the 'A:' drive. Many 
common drivers are also included with the 'Windows 95' software.



6]      Locate the folder where the appropriate drivers are located and select it.

7]      Choose 'OK'.

8]      Choose 'OK' in the 'Install from Disk' dialog box.

9]      Choose 'OK'.

10]      Choose the 'Finish' button.



  

Audio mixer volume down; Push up Wave input slide 
bars or remove mute.

Cause:

No sound is coming from the computer because Wave output is turned down or muted in the mixer.

Solution:

Turn up the Wave input in the mixer.

1)      Choose 'Start'.

2)      Select 'Programs' and select 'Accessories'.

3)      Select 'Multimedia' and select 'Volume Control'.

4)      To turn up the Wave input, do the following:

a)      If the 'Mute All' check box is checked, select the check box.

b)        If the 'Mute' check box in the 'Wave Output' section of the 'Volume Control' is checked, select the 
check box.

c)      Drag the 'Wave Output' slider to the desired level.



  

Connection wrong; Disconnect CD-ROM & connect to 
sound card output jack.

Cause:

There is no sound coming from the computer because the speakers are not connected to the sound card.

Solution:

Connect the speakers to the sound card.

1)      Locate the sound card speaker jack on the computer. 

NOTE: The sound card may have several different options which may make it confusing to locate.    The 
speaker jack generally looks similar to a headphone jack and may have a symbol over it that looks like 
sound waves coming from a half-circle.    If the computer has a modem, it may be part of the sound card.    If 
this is true, a phone cable will be plugged in to the sound card. 

2)      If the speakers are on, turn them off and carefully plug the speaker cable into the sound card speaker jack.

3)      Make sure that the speaker cable is plugged into the speakers and turn the speakers on.



  

Microphone settings; Increase microphone settings in 
the Windows audio mixer.

Cause:

The microphone cannot record because the microphone line-in setting is too low.

Solution:

Turn up the microphone line-in setting.

1)      Choose 'Start'.

2)      Select 'Programs' and select 'Accessories'.

3)      Select 'Multimedia' and select 'Volume Control'.

4)      If the 'Master Out' dialog box appears, do the following:

a)        Select the 'Options' menu and select 'Properties'.

      Properties  

b)     Under 'Adjust volume for' select the 'Recording' radio button.
c)     In the 'Show the following volume controls:', make sure that there is a check in all of the check boxes.
d)     Choose 'OK'.    (The 'Wave Input' box appears.)

      'Wave Input' box  

5) To turn up the microphone line setting, drag the 'Line' slider to the desired level.

6) To turn up the microphone volume setting, drag the 'Mic' slider to the desired level.



  

Connection wrong; Connect microphone securely to 
'input' jack on sound card.

Cause:

Sound cannot be recorded because there is a problem with the microphone connection.

Solution:

Reconnect    the microphone.

1)      Locate the microphone jack on the sound card.

2)      Plug the microphone into the microphone jack.



   

Possible defective microphone; Contact manufacturer.

Cause:

Sound cannot be recorded because the microphone may be defective.

Solution:

Contact the manufacturer regarding warranty and replacement information or the place where the microphone 
was purchased.



  

IRQ not supported; IRQ setting is not supported by 
program or game.

Cause:

 IRQ setting is not supported by program or game.

Solution:

Some games do not support an IRQ setting above a certain number (usually 9).    Check the documentation that 
came with the DOS program or game, and check the sound card IRQ setting in the computer.

1)      To check the IRQ setting:

2)      Choose the    'Start' button.

3)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

4)      Double-click the 'System' icon.

      'System' icon  
5)      Choose the 'Device Manager' tab.
6)      Double click on 'Sound, Video and Game Controllers'.

      Sound, Video and Game Controllers  
7)      Double click on the sound card listed .
8)      Choose the 'Resources' tab.

Note the Interrupt Request number assigned to the sound card.    See if this number is higher than the 
highest IRQ number suggested by the documentation.

9)      Select 'Cancel'.

10)      Make sure that 'Interrupt request (IRQ)' is selected.

11)      Double click on 'Computer'.

      Computer  

12)      Check the list showing the IRQ number assigned to each device on your computer.    Determine an IRQ 
number that is not being used by another device that may be lower than recommended.

      IRQ number assigned  
13)      Select 'Cancel'.
14)      Double click on the sound card again.
15)      Choose the 'Resources' tab again.
16)      If 'Use automatic settings' is selected, unselect it.

      Use automatic settings  
17)      In the 'Resource Listings' box, double click on 'Interrupt Request'.



      Interrupt Request  
18)      In the 'Value' box, enter the IRQ number you wish to set for the sound card.

      'Value' box  
19)      Choose 'OK' from each    dialog box until you return to the 'Control Panel'.



  

No sound from DOS applications; IRQ conflict.

Cause: 

IRQ conflict

Solution:

To resolve the IRQ conflict:

1)      Choose the    'Start' button.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click the 'System' icon.

      'System' icon  
4)      Choose the 'Device Manager' tab.
5)      Double click on 'Sound, Video and Game Controllers'.

      Sound, Video and Game Controllers  
6)      Double click on the sound card listed .
7)      Choose the 'Resources' tab.
8)      Note under the 'Conflicting Device List' box if it indicates that there is any conflict with another device.

      Conflicting Device List  
9)      If yes, note the IRQ address that it is conflicting with.
10)      Select 'Cancel'.
11)      Make sure that 'Interrupt request (IRQ)' is selected.
12)      Double click on 'Computer'.

      Computer  
13)      Check the list showing the IRQ number assigned to each device on your computer.    Determine an IRQ 
number that is not being used by another device.

      IRQ number assigned  
14)      Select 'Cancel'.
15)      Double click on the sound card again.
16)      Choose the 'Resources' tab again.

17)      If    'Use automatic settings' is selected, unselect it.

      Use automatic settings  

18)      In the 'Resource Listings' box, double click on 'Interrupt Request'.

      Interrupt Request  
19)      In the 'Value' box, enter the IRQ number you wish to set for the sound card.

      'Value' box  



20)      Choose 'OK' from each    dialog box until you return to the 'Control Panel'.



   

DOS driver not installed; Re-install sound card's DOS 
driver.

Cause:

There is no sound coming from the speakers because the DOS sound drivers are not installed or are corrupted.

Solution:

Install or reinstall the sound drivers.

1)      Choose 'Start'.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click 'Add New Hardware'.

      Add New Hardware  
4)      To install or reinstall a new sound driver, do the following:

a)    Choose the 'Next' button.

b)      Select the 'No' button.

c)      Choose the 'Next' button.

d)      Select the 'Sound, Video and Game Controllers' entry in the 'Hardware Types' list box.

      Sound, Video and Game Controllers  

e)      Select the 'Next' button.
f)      To locate the type of sound card driver and install it, do the following:

1]      Select the manufacturer of the sound card in the 'Manufacturers' list box.

      Manufacturers  

NOTE: If unsure of the manufacturer, consult the sound card documentation. If there is no 
documentation, Creative Labs is a common manufacturer of sound cards. Many cards will operate 
using one of    the Creative Labs drivers.

2]      Select the sound card model from the 'Model Type' list box.

NOTE: Again, if unsure of the model type, consult the sound card documentation. If there is no 
sound card documentation, many sound cards will function if the 'Sound Blaster' driver is selected.

3]      Choose the 'Have Disk' button.

4]      Choose the 'Browse' button.

5]      Insert the disk with the sound card drivers in the appropriate drive.

NOTE: If the drivers are on a '3 1/2' diskette, the appropriate drive will be the 'A:' drive. Many 



common drivers are also included with the 'Windows 95' software.

6]      Locate the folder where the appropriate drivers are located and select it.

7]      Choose 'OK'.

8]      Choose 'OK' in the 'Install from Disk' dialog box.

9]      Choose 'OK'.

10]      Choose the 'Finish' button.



  

Volume too low; Increase software program's mixer 
control volume setting.

Cause:

There is no sound available while running a DOS software because the DOS software mixer volume is set to 
zero.

Solution:

Open the appropriate DOS software and increase the mixer volume for that software.



   

Audio driver incorrect; Re-install the correct audio 
driver.

Cause:

There is no sound coming from the speakers because the audio drivers are corrupt or obsolete.

Solution:

Install or reinstall the audio drivers.

1)      Choose 'Start'.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click 'Add New Hardware'.

      Add New Hardware  
4)      To install or reinstall a new sound driver, do the following:

a)    Choose the 'Next' button.

b)      Select the 'No' button.

c)      Choose the 'Next' button.

d)      Select the 'Sound, Video and Game Controllers' entry in the 'Hardware Types' list box.

      Sound, Video and Game Controllers  

e)      Select the 'Next' button.
f)      To locate the type of sound card driver and install it, do the following:

1]      Select the manufacturer of the sound card in the 'Manufacturers' list box.

      Manufacturers  

NOTE: If unsure of the manufacturer, consult the sound card documentation. If there is no 
documentation, Creative Labs is a common manufacturer of sound cards. Many cards will operate 
using one of    the Creative Labs drivers.

2]      Select the sound card model from the 'Model Type' list box.

NOTE: Again, if unsure of the model type, consult the sound card documentation. If there is no 
sound card documentation, many sound cards will function if the 'Sound Blaster' driver is selected.

3]      Choose the 'Have Disk' button.

4]      Choose the 'Browse' button.

5]      Insert the disk with the sound card drivers in the appropriate drive.



NOTE: If the drivers are on a '3 1/2' diskette, the appropriate drive will be the 'A:' drive. Many 
common drivers are also included with the 'Windows 95' software.

6]      Locate the folder where the appropriate drivers are located and select it.

7]      Choose 'OK'.

8]      Choose 'OK' in the 'Install from Disk' dialog box.

9]      Choose 'OK'.

10]      Choose the 'Finish' button.



  

Audio connection; Connect audio cable to sound card, 
speakers together & to power.

Cause:

The sound is too low because the cable connections are bad.

Solution:

Reconnect or replace the cables.

1)      Check speakers to ensure that one speaker is plugged into the other speaker (main speaker)

2)      Check that power cable (if your speakers require an outside power source) is connected to electrical outlet 
and to the main speaker.

3)      Check to ensure that the audio cable goes from the main speaker to the output jack on the sound card 
(located at the back of the computer base unit.)



  

Sound file of poor quality; Attempt to obtain another 
copy of the file.

Cause:

Sound file of poor quality

Solution:

Attempt to obtain another copy of the file.    If the file was created in such a way that all copies of the file would 
be of poor quality, there is no way to resolve this problem.



  

Speaker connection wrong; Connect speakers together 
using appropriate jacks.

Cause:

Speaker connection is wrong.

Solution:

The speaker that has the connection to the sound card is the main speaker.    The other speaker should plug into 
the main speaker.    The main speaker may also contain a power cord connection (not all speakers do).    Be sure 
when connecting the speakers that you look for any symbols or words on the speaker indicating which cord 
should be plugged into which jack on the main speaker.    Otherwise, look to any installation information that 
came with the speakers or PC.



  

Sound not balanced between speakers; Adjust balance 
in the audio mixer.

Cause:

There is an incorrect balance in audio mixer.

Solution:

Sound not balanced between speakers; Adjust balance in the audio mixer

1)      Choose the 'Start' button to display the Windows 'Start' menu.

2)      Select 'Programs'.

3)      Select 'Accessories'.

4)      Select 'Multimedia'.

5)      Select 'Volume Control'.    (The 'Master Out' or the 'Wave Input' dialog box appears.)

6)      If the 'Wave Input' dialog box appears, do the following:

a)      Select the 'Options' menu and select 'Properties'.

b)      Under 'Adjust volume for' select the 'Playback' radio button.

      'Playback' radio button  

c)      In the 'Show the following volume controls', make sure that there is a check in all of the check boxes.

      Show the following volume controls:  
d)      Choose 'OK'.    (The 'Master Out' box appears.)

7)      Use the mouse button to click and hold down on a balance control slide bar.

      slide bar  

8)      With the mouse, move the slide bar to the right to change the balance.
9)      Release the mouse button when the balance is at a desired level.
10)      Repeat steps 7) through 9) on all slide bars in the 'Master Out' dialog box.
11)      When you have completed increasing the volume of all slide bars, select the 'Options' menu and select 'Exit'.



  

Sound not balanced; Adjust balance using the balance 
control on the speakers.

Cause:

Balance on speakers is incorrect.

Solution:

Adjust balance using the balance control on the speakers.

Not all speakers have a balance control. 



   

Slow performance; Suggested temporary fixes to 
system performance.

Solution:

Slow performance; Suggested temporary fixes to system performance

Suggested temporary fixes:

1)      Remove any TSR (terminate-and-stay-resident) programs that compete for CPU time.

NOTE: A TSR (terminate-and-stay-resident) program is one that is automatically started by the computer's 
AUTOEXEC.BAT file when the computer is started up. There is a line in the AUTOEXEC.BAT containing a 
command that causes that program to start.    See HOW TO EDIT THE AUTOEXEC.BAT FILE.

EXAMPLE: An anti-virus program that scans the computer's hard drive every time the computer is turned 
on.

2)      Run only one Windows application at a time.

3)      Check with the sound card manufacturer to make sure that you are running the most current drivers for that 
sound card.



   

IRQ conflict; Correct IRQ conflict between sound 
card and another device.

Cause:

There is an IRQ conflict between the sound card and another device.

Solution:

To resolve the IRQ conflict:

1)      Choose the    'Start' button.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click the 'System' icon.

      System' icon  
4)      Choose the 'Device Manager' tab.
5)      Double click on 'Sound, Video and Game Controllers'.

      'Sound, Video and Game Controllers'  
6)      Double click on the sound card listed .
7)      Choose the 'Resources' tab.
8)      Note under the 'Conflicting Device List' box if it indicates that there is any conflict with another device.

      Conflicting Device List  
9)      If yes, note the IRQ address that it is conflicting with.
10)      Select 'Cancel'.
11)      Make sure that 'Interrupt request (IRQ)' is selected.
12)      Double click on 'Computer'.

      Computer  
13)      Check the list showing the IRQ number assigned to each device on your computer.    Determine an IRQ 
number that is not being used by another device.

      IRQ number assigned  
14)      Select 'Cancel'.
15)      Double click on the sound card again.

16)      Choose the 'Resources' tab again.

17)      If    'Use automatic settings' is selected, unselect it.

      Use automatic settings  

18)      In the 'Resource Listings' box, double click on 'Interrupt Request'.

      Interrupt Request  
19)      In the 'Value' box, enter the IRQ number you wish to set for the sound card.



      'Value' box  
20)      Choose '    OK' from each dialog box until you return to the 'Control Panel'.



  

Probably setup problem; Contact your Internet 
service provider.

Cause:

The cause is probably a setup problem.

Solution:

Contact your Internet service provider.    Your modem setup may require more advanced 'custom' setup 
information.    Your Internet service provider can assist you in determining the setup information required.    
There should be a technical support number provided with your software.



  

No Internet service provider; Obtain an Internet 
service provider.

Cause:

You have no Internet service provider

Solution:

Obtain an Internet service provider.    Some common Internet service providers are: Microsoft Internet Explorer, 
Netscape, America Online, Compuserve, and Prodigy, but there are many more.    All charge a fee for their 
service.    Computer oriented magazines will often have advertisements and information about Internet 
providers.    Usually, the software for one or more Internet service providers is included with the purchase of a 
new computer or modem.



  

No modem; Install internal or external modem in your 
computer.

Cause:

You have no modem from which to access the Internet.

Solution:

Install internal or external modem in your computer.    Internal modems are installed inside your computer.

External modems are a separate unit that sits outside of your computer, but must be connected to the main 
computer unit via an adapter card.

See HOW TO INSTALL AN INTERNAL MODEM 

or 

HOW TO INSTALL AN EXTERNAL MODEM



  

Phone connection wrong; Connect line from the 
modem to the telephone line.

Cause:

The phone connection is wrong.

Solution:

Connect line from the modem to the telephone line.    Consult the documentation that came with your modem to 
determine:

1)      How many connection cords are necessary.

2)      If any adapters (to allow 2 lines to plug into the same jack) are needed.

3)      If the connection cords are connected to the correct jacks on the base unit, telephone wall jack or 
telephone.



   

Contact the computer manufacturer to determine if 
resolution is available.

Solution:

Contact computer manufacturer.    If static continues,    the physical location of the sound card within the 
computer may be too close to the computer's cooling fan. Depending on the physical structure of the slots inside 
your computer, you may be able to move your sound card to another slot further away from the cooling fan.    
Otherwise, contact the computer's manufacturer to see if there is any resolution to the problem.



   

Correct printer setup in the page setup.

Cause:

The print job is being sent to a laser (black and white) printer.

Solution:

The following instructions will not be the same in all applications, but will apply to most:

1)      Select the 'File' menu and select 'Print'.

      Print  

2)      In the 'Printer' box locate 'Name' or 'Type' of printer to see which printer is selected. 
3)      To change to another printer, select the arrow at the end of the box where the printer name is showing.    (A 
drop-down list of installed printers will be shown.)    Select the correct printer, then print your document again.



  

Incorrect print driver for Win95; Choose correct print 
drivers.

Cause:

The incorrect print drivers are loaded on the PC.

Solution:

Install the print drivers found on the software diskette that came with the printer.    If no software came with the 
printer, contact the printer manufacturer or the place where you purchased the printer.



  

UART chip is not fast enough; Obtain a 16550 or 
higher chip.

Cause:

The UART chip is not fast enough.

Solution:

CAUTION: Installation of a chip within the computer should only be performed by a qualified computer 
technician. 

The 16550 chip is a standard in most IBM PS/2 and 386 computers, as well as practically all 486 and above 
computers.

Contact your computer manufacturer.



  

An adapter is needed to attach to the sound card.

Cause:

An adapter is needed to attach to the sound card.

Solution:

Add an adapter to the connector to attach to sound card.    Purchase an adapter (at any electronics store) to fit 
over the end of the plug on the cable. 



  

Within the application, select the sound card.

Cause:

The sound card is not selected.

Solution:

Select the sound card from within the game program.    Within one of the menus at the top of the screen, select 
the word 'Sound' so that a check mark appears in front of the word. (The exact location within the menus may 
vary for each game.)



 

   

CD drive not found; Turn off computer, turn    on CD 
drive, then turn on computer.

Cause:

The CD-ROM was not turned on first.    In order for this CD-ROM to work it must be turned on before the PC 
is.

Solution:

Turn off computer, turn on CD drive, then turn on computer.    When computer is turned on, the computer's 
startup files search for devices attached to the computer    and load the driver information to recognize the 
device.    If the external CD-ROM drive is not turned on prior to turning on the computer, the startup files don't 
see it and therefore, is not recognized by the computer.



   

You are trying to play from a WAV or MIDI disk. 
Insert an audio disk.

Cause:

You are trying to play from a WAV or MIDI disk and should be playing a music CD.

Solution:

Insert an audio disk.    An audio disk is a music CD that can be played from any home stereo system.



  

Clean the CD.    Handle CD by the edges to keep clean.

Cause:

The CD is distorted because it is dirty.

Solution:

Clean the CD.    Handle CD by the edges to keep clean. Only use a CD cleaning kit to clean the CD.    Cleaning 
by other methods may leave a film or scratch the CD.



      

The disk is incompatible.    Use a double density disk.

Cause:

The disk is incompatible with your type of hard drive.

Solution:

Use a double density disk. An ED is an extended capacity diskette and is only compatible with extended density 
drives.    An ED disk can hold about 4 M of data.



   

Choose a different palette for your monitor display 
settings.

Cause:

The wrong color palette is chosen for a monchrome monitor. 

Solution:

Choose a different palette for your monitor display settings:

1)      Choose 'Start'.

2)      Select 'Settings'. 

3)      Select 'Control Panel'.

      Control Panel  

4)      Double-click on the 'Display' icon.

      'Display' icon  
5)      Choose the 'Settings' tab.
6)      Click on the arrow at the end of the 'Color Palette' box. (A drop-down list of options appears.)

      'Color Palette' box  
7)      Select a different palette option.
8)      Select 'OK'.



   

Look in the PC's manual, look on the hard drive itself, 
or call the PC maker.

Solution:

Look in the PC's manual, look on the hard drive itself, call the PC drive manufacturer or look at the 'Device 
Manager'

To look at Device Manager for hard disk drive information:

1)      Choose 'Start'

2)      Select 'Settings' 

3)      Select 'Control Panel'.

      Control Panel  

4)      Double-click on the 'System' icon.

      'System' icon  
5)      Choose the 'Device Manager' tab.
6)      Double click on 'Disk Drives'.

      Disk Drives  

NOTE: The information displayed may not be very specific, but will give a general 'type' of disk drive.



   

Clean the dust out of the computer and reinstall the 
adapter card.

Cause:

Dust in the computer has caused the short.

Solution:

Always clean out dust before inserting adapter card.    Dust will cause the card to short.

Use a can of compressed air designed to blow dust out of computers.    Be careful of using a vacuum unless it is 
designed for vacuuming electronic equipment.



   

Change the termination settings of the SCSI device.

Cause:

The SCSI scanner will not install because the SCSI cable is not properly terminated.

Solution:

Terminate the SCSI cable properly.

1)      Locate the middle connector in the SCSI cable.

2)      Plug the scanner into the middle connector.

3)      Take a terminator plug and place it at either end of the SCSI cable.



   

Change resolution to black and white to print faster.

Cause: 

Resolution is too high to allow fast printing

Solution:

Every scanner is different, therefore, consult your scanner user guide to determine how to change the resolution 
and color depth.

To give you general idea how to change the resolution and color depth of your scanner, below are instructions 
for the Hewlett Packard ScanJet 3c:

1)      Select the 'Custom' menu and select 'Print Path'.    (The 'Custom Print Path' dialog box appears.)

2)      To change the color depth, do the following:

a)      Select the 'Tools' menu and select 'Color Adjustment'.    (The 'Color Adjustment' box appears.)

b)      Under 'Saturation', click the left arrow to reduce the amount of color on the scanning image.

3)      To change the printer resolution, do the following:

a)      Find your printer in the list box.    If you cannot find your printer in the list, skip to 'Changing 
resolution when printer is not listed'. 

b)      Select the printer.    (The dpi (dots per inch) appear in the 'Drawings and Halftones' and 'Photos' 
boxes.)

c)      Choose 'OK'.

Changing resolution when printer is not listed (Hewlett Packard ScanJet 3c):

1)      Select the 'Custom' menu and select 'Print Path'.    (The 'Custom Print Path' dialog box appears.)

2)      Determine the dpi (dots per inch) of your printer.    (Consult your printer manual to determine dpi.    Also, 
the printer have the dpi stamped on the printer.)

3)      Enter the horizontal dpi in the 'Horizontal' box under 'Drawings and Halftones'.

4)      Enter the vertical dpi in the 'Vertical' box under 'Drawings and Halftones'.

5)      Divide the horizontal dpi by 2 and enter that number in the 'Horizontal' box under 'Photos'.    For example, 
if the horizontal dpi of the printer is 300, enter 150 in the 'Horizontal' box under 'Photos'.

6)      Divide the vertical dpi by 2 and enter that number in the 'Vertical' box under 'Photos'.    For example, if the 
vertical dpi of the printer is 300, enter 150 in the 'Vertical' box under 'Photos'.

7)      Choose 'OK'



   

Simplify the page to be printed or expand the printer 
memory.

Cause: 

Printer does not have enough memory to print the complex document

Solution:

Use only one or two fonts and/or remove graphics to simplify the document.

For example, to simplify a Microsoft Word document, do the following:

1)      To change the text font:

a)      Select the text to change:

1]      Click the mouse button at beginning of the text to change.

2]      Drag the cursor to the end of the last word to change.

3]      Release the mouse button.

b)      Select the 'Format' menu and select 'Font'.    (The 'Font' dialog box appears.)

      'Format' menu  

c)      Select the 'Font' tab.
d)      Select the font from the 'Font' list box.    Use the arrows on the side of the list box to see other fonts.

      'Font' list box  
e)      Choose the 'OK' button.

2)      To remove graphics from a Word document:

a)      Click on the graphic to be removed.

b)      Select the 'Edit' menu and select 'Clear'.



   

Decrease print density settings to lighten the images.

Cause: 

Print density is set too high

Solution:

All graphic applications and printers are different.    Please consult your application    and printer documentation 
for specific details.    Below are general instructions that will help you get started:

1)      Select the 'File' menu and select 'Print'.    (The 'Print' dialog box appears.)

      Print  '

2)      In the 'Name' drop down list box, make sure the correct color printer is selected.
3)      Choose the 'Properties' button.
4)      Choose the 'Options' button.    (The 'Options' dialog box appears.)
5)      Look for 'Print Density' or 'Intensity' and decrease the intensity.
6)      Choose 'OK' until you reach the main 'Print' dialog box.
7)      Choose 'OK'.



   

Change the page setup to print in gray scale.

Cause: 

Printer set to a scale that is too dark.

Solution:

All graphic applications and printers are different.    Please consult your application    and printer documentation 
for specific details.    Below are general instructions that will help you get started:

1)      Select the 'File' menu and select 'Print'.    (The 'Print' dialog box appears.)

      Print  

2)      In the 'Name' drop down list box, make sure the correct color printer is selected.
3)      Choose the 'Properties' button.
4)      Select the 'Print in gray scale'.
5)      Choose 'OK'.
6)      Choose 'OK' again.



   

The wrong printer was selected.    Select the correct 
printer.

Cause: 

Wrong printer selected

Solution:

Setting the printer may vary from one application to another, but these general instructions may help:

1)      From the 'File' menu at the top of the program, choose 'Print'.

      Print  

Note the printer name shown as the printer that will be used.

2)      Obtain a list of printers by either

a)      Selecting 'Printer Setup', 'Options' or 'Properties'

OR

b)      Selecting the down arrow at the end of the box containing the current printer name, then selecting the 
correct printer.



      

Speakers may be damaged; Replace speakers.

Cause:

Speakers may be damaged.

Solution:

Replace the speakers.    Before replacing speakers, attempt to attach them to another computer to see if static 
continues.    If speakers still under warranty, contact manufacturer.



      

Turn the music CD label side up and replay the CD.

Cause:

The CD is turned up side down.

Solution:

Turn the music CD label side up and replay the CD.



   

Wave file corrupt; Re-install the Wave file.

Cause:

The Wave (.wav) file is corrupt

Solution:

Re-install the corrupt Wave file(s) from the original source diskette or CD;    If the file is on a CD (such as a 
game), contact the manufacturer.



  

MIDI file corrupt; Re-install the MIDI file.

Cause:

The MIDI (.mid) file is corrupt

Solution:

Re-install the corrupt MIDI file(s) from the original source diskette or CD;    If the file is on a CD (such as a 
game), contact the manufacturer.



  

CD-ROM drive does not work; Connect drive to 
second IDE connector.

Cause:

If the CD drive does not work when connected to the first IDE connector, the second connector must be used. 
This puts CD-ROM drive on the same controller as the hard drive.

Solution:

Connect CD drive to second IDE connector on the hard disk, not the one with the sound card. 

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician.

1)      Open the computer case.

2)      Unplug the ribbon cable between the sound card and the CD drive from the CD drive.

NOTE: Be sure not to unplug the audio cable between the sound card and CD drive.

3)      Plug the unused connector from the ribbon cable on the hard drive controller into the now open plug on the 
CD drive. 



  

Cannot correct problem; Scanner or computer not 
able to perform faster.

Cause:

Possible causes for slow performance:

Serial and parallel scanners work more slowly that SCSI type scanners. 

If CPU clock speed is slow (MHz speed of computer), scanner will perform more slowly.

Solution:

Hardware limitations can generally only be overcome by replacing the hardware. Contact the scanner 
manufacturer for further information regarding this problem.



   

Sound drivers incorrect; Install correct sound drivers.

Cause:

There is no sound coming from the speakers because the sound drivers are not installed or are corrupted.

Solution:

Install or reinstall the sound drivers.

1)      Choose 'Start'.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click 'Add New Hardware'.

      Add New Hardware  
4)      To install or reinstall a new sound driver, do the following:

a)    Choose the 'Next' button.

b)      Select the 'No' button.

c)      Choose the 'Next' button.

d)      Select the 'Sound, Video and Game Controllers' entry in the 'Hardware Types' list box.

      Sound, Video and Game Controllers  

e)      Select the 'Next' button.
f)      To locate the type of sound card driver and install it, do the following:

1]      Select the manufacturer of the sound card in the 'Manufacturers' list box.

      Manufacturers  

NOTE: If unsure of the manufacturer, consult the sound card documentation. If there is no 
documentation, Creative Labs is a common manufacturer of sound cards. Many cards will operate 
using one of    the Creative Labs drivers.

2]      Select the sound card model from the 'Model Type' list box.

NOTE: Again, if unsure of the model type, consult the sound card documentation. If there is no 
sound card documentation, many sound cards will function if the 'Sound Blaster' driver is selected.

3]      Choose the 'Have Disk' button.

4]      Choose the 'Browse' button.

5]      Insert the disk with the sound card drivers in the appropriate drive.

NOTE: If the drivers are on a '3 1/2' diskette, the appropriate drive will be the 'A:' drive. Many 
common drivers are also included with the 'Windows 95' software.



6]      Locate the folder where the appropriate drivers are located and select it.

7]      Choose 'OK'.

8]      Choose 'OK' in the 'Install from Disk' dialog box.

9]      Choose 'OK'.

10]      Choose the 'Finish' button.



   

No sound from speakers due to speakers not receiving 
power.

Cause:

There is no sound coming from the speakers because the speakers are not receiving power.

Solution:

Check the speakers' power cord to make sure it is plugged in properly and turn the speakers on.

1)      Check the speakers' power cord and make sure it is plugged in properly.

2)      Turn on the speakers.

NOTE: If the speakers are still not receiving power after the power cord has been checked, properly 
plugged in and the speakers turned on, the problem may be a bad power cord. 



  

Re-install the sound card's DOS driver.

Actions:

Install or reinstall the sound drivers.

1)      Choose 'Start'.

2)      Select 'Settings' and select 'Control Panel'.

      Control Panel  

3)      Double-click 'Add New Hardware'.

      Add New Hardware  
4)      To install or reinstall a new sound driver, do the following:

a)    Choose the 'Next' button.

b)      Select the 'No' button.

c)      Choose the 'Next' button.

d)      Select the 'Sound, Video and Game Controllers' entry in the 'Hardware Types' list box.

      Sound, Video and Game Controllers  

e)      Select the 'Next' button.
f)      To locate the type of sound card driver and install it, do the following:

1]      Select the manufacturer of the sound card in the 'Manufacturers' list box.

      Manufacturers  

NOTE: If unsure of the manufacturer, consult the sound card documentation. If there is no 
documentation, Creative Labs is a common manufacturer of sound cards. Many cards will operate 
using one of    the Creative Labs drivers.

2]      Select the sound card model from the 'Model Type' list box.

NOTE: Again, if unsure of the model type, consult the sound card documentation. If there is no 
sound card documentation, many sound cards will function if the 'Sound Blaster' driver is selected.

3]      Choose the 'Have Disk' button.

4]      Choose the 'Browse' button.

5]      Insert the disk with the sound card drivers in the appropriate drive.

NOTE: If the drivers are on a '3 1/2' diskette, the appropriate drive will be the 'A:' drive. Many 
common drivers are also included with the 'Windows 95' software.

6]      Locate the folder where the appropriate drivers are located and select it.

7]      Choose 'OK'.

8]      Choose 'OK' in the 'Install from Disk' dialog box.

9]      Choose      'OK'. 

10]      Choose the 'Finish' button.



   

Volume too low; Increase DOS mixer control volume 
setting.

Cause:

There is no sound in a DOS application because the DOS sound mixer volume is set to zero.

Solution:

From the DOS prompt, start your sound card's DOS mixer program and change the volume setting.

1)      Locate your sound card documentation and determine the name and location of the DOS mixer program. 
(e.g., C:\SOUNDCARD\VOLSET.EXE)

2)      Go to the DOS prompt.

a)    Open the 'Start' menu.

b)      Select 'Programs'.

c)    Select 'MS-DOS Prompt'.

3)      From the DOS prompt, change directory to the appropriate directory.

a)      For example, if the directory where the DOS mixer program is located is named 'Soundcard' enter 'CD 
SOUNCARD' and press ENTER.

4)      Type the appropriate command to start the DOS mixer program and press ENTER.

a)      For example, if the program is named 'Volset.exe,' type 'VOLSET' and press ENTER.

5)      When the program has started, locate the master volume control and change the setting.



  

Volume turned down; Turn up the volume dial on the 
speakers and sound card.

Cause:

Sound from speakers is too low because volume dial on sound card or speakers is turned down.

Solution:

Turn the speaker or sound card volume up.

Do one or both of the following:

1)      Speakers:

a)      Locate the volume control on the speakers.

b)      Turn the speaker volume up.

2)      Sound Card: 

NOTE: Not all sound cards have volume dials.    If yours does not, volume can only be controlled by 
adjusting controls on the speaker or in software programs.

a)      Locate the sound card.    Face the back of the computer and locate the jack where the speakers are 
connected.

b)      The volume dial should be located just above or below the speaker jack.

c)      Adjust the volume dial appropriately.



  

Speaker wires damaged; Replace speaker wires.

Cause:

Static from speakers when playing sound files because speaker wire may be damaged.

Solution:

Contact the computer manufacturer or go to a computer store to obtain a speaker wire that is compatible with 
your speakers and computer.    Consult the speakers' user manual for additional information. 



  

Possible damaged speaker or sound card. Contact 
manufacturer.

Cause:

No sound from one speaker when playing sound files because speaker or sound card may be damaged

Solution:

If possible, locate another set of computer speakers and try.    If they work, then contact your speaker 
manufacturer.    If they do not work, contact your sound card manufacturer.



  

Sound pauses during playback due to system 
performance limitations..

Cause:

Sound pauses during playback because system has reached performance threshold.

Solution:

Suggested temporary fixes:

1)      Remove any TSR (terminate-and-stay-resident) programs that compete for CPU time.

2)      Run only one Windows application at a time.

3)      Check with the sound card manufacturer to make sure that you are running the most current drivers for that 
sound card.



  

Possible defective speakers; Contact manufacturer.
Cause:

              There is no sound coming from the speakers because the speakers may be defective.

Solution:

              Contact the manufacturer of the speakers or the place where speakers were purchased.



  

17xx Hard disk failure; Troubleshoot disk 
drive/controller subsystem

Cause:

Failed or intermittent ST-506/412 fixed disk/controller adapter, caused by the devices themselves, their 
installation, interconnecting cables or environment. Suspect damage from electrostatic discharge, poor solder 
connections, misaligned cabling, bad connections, bad bearings, worn parts, failed discrete components, wrong 
jumper connections, virus contamination and/or excessive heat.

Solution:

Troubleshoot disk drive/controller subsystem.

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician.

1)      Check the connections and verify that the computer environment is no higher that 85 degrees.

2)      Check that the computer cooling fan is not obstructed.

3)      Make sure power cable is securely connected to power connector on drive.

4)      Inspect and correct data cable installation between the controller card and all hard disk drives.    Make sure 
cables are securely connected.

5)      Verify correct jumper settings on hard disk drive(s) with owner's manual.

6)      Try swapping controller card to isolate problem to the controller card.    Replace the original controller card 
if the second controller card solves the problem.

7)      Switch hard disks to isolate problem to hard disk.    Replace the original hard disk if the second hard disk 
works properly.



  

Fixed disk or hard disk failure; Troubleshoot disk 
drive/controller subsystem.

Cause:

Failed or intermittent ST-506/412 fixed disk/controller adapter, caused by the devices themselves, their 
installation, interconnecting cables or environment. Suspect damage from electrostatic discharge, poor solder 
connections, misaligned cabling, bad connections, bad bearings, worn parts, failed discrete components, wrong 
jumper connections, virus contamination and/or excessive heat.

Solution:

Troubleshoot disk drive/controller subsystem.

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician.

1)      Check the connections and verify that the computer environment is no higher that 85 degrees.

2)      Check that the computer cooling fan is not obstructed.

3)      Make sure power cable is securely connected to power connector on drive.

4)      Inspect and correct data cable installation between the controller card and all hard disk drives.    Make sure 
cables are securely connected.

5)      Verify correct jumper settings on hard disk drive(s) with owner's manual.

6)     Try swapping controller card to isolate problem to the controller card.    Replace the original controller card 
if the second controller card solves the problem.

7)      Switch hard disks to isolate problem to hard disk.    Replace the original hard disk if the second hard disk 
works properly.



    

 

Drive not ready; Ensure diskette inserted properly, 
close drive latch

Cause:

If the drive is a floppy drive, the problem may be a missing diskette, a diskette inserted upside down or 
backwards, a drive door not securely closed, a drive door sensor broken, a bad cable, a bad drive, or a bad 
diskette.    If hard drive, there may be timing incompatibilities.

Solution:

Make sure diskette is correctly installed and drive door completely closed.

Do one of the following:

1)      If the drive is floppy drive:

a)      Make sure diskette is correctly installed.

b)      Make sure drive door is completely closed.

c)      Press 'R' to retry access.

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a 
qualified computer technician.

d)      Try accessing floppy diskette in another drive or on another computer.

e)      Use file/disk recovery utility to inspect and repair floppy diskette.

f)     Inspect floppy drive cable for damage and secure connections.    Replace if necessary.

g)      Replace floppy drive.

2)     If drive is hard disk:

a)      Press 'R' to retry access (Usually problem disappears on 2nd attempt).

b)      Use file/disk recovery utility to inspect and repair hard disk.



   

1791 Disk 1 error; Check power cable

Solution:

Troubleshoot disk drive/controller subsystem.

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician.

1)      Make sure power cable is securely connected to power connector on drive.

2)     Inspect and correct data cable installation between the controller card and all hard disk drives.    Make sure 
cables are securely connected.

3)      Verify correct jumper settings on hard disk drive(s) with owner's manual.

4)      Try swapping controller card to isolate problem to controller card.    Replace the original controller card if 
the second controller card solves the problem.

5)      Switch hard disks to isolate problem to hard disk.    Replace the original hard disk if the second hard disk 
works properly.

NOTE: Disk 1 is second physical drive, usually named logical drive 'D', unless drives are partitioned into 
additional logical drives.    Hard disk controller did not receive expected response from disk.    Causes 
include disconnected power cable to disk, incorrectly installed data cable, incorrectly set jumpers on drive, 
bad hard disk, or bad controller card.



  

Out of environment space; Remove TSR or use 
SHELL command to increase space

Cause:

The problem could be caused by a loaded TSR that blocks DOS from further expanding its environment space, 
attempting to use the SET command to expand a full environment space, or using an application that requires a 
large environment space.

Solution:

Remove TSR from memory or increase the environment space with the SHELL command.

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician.

Do one of the following, in sequence, until the problem is solved:

1)      Remove any TSRs from memory and retest.

2)      Increase the environment space using SHELL:

a)      Edit CONFIG.SYS.

b)      Add the following command to CONFIG.SYS:

SHELL=COMMAND.COM /E:1024 /P

(NOTE: The '/E' switch in the SHELL command sets the DOS environment space in bytes)

c)      Save the file and Press CTRL+ALT+DEL to reboot the computer.



   

Start PC from hard disk to set up DoubleSpace; 
Create DBLSPACE.INI file

Cause:

This error may occur when attempting to recover an unmounted compressed volume file (CVF) by booting with 
an MS-DOS 6.0 boot diskette in Drive A.    The problem is that DBLSPACE.INI cannot be found.

Solution:

Use DOS Editor to create a DBLSPACE.INI file with appropriate settings.    Save file to the root directory of the 
hard disk and reboot the computer.



   

Video card and monitor bad; Replace video adapter 
card and monitor

Cause:

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician.

1)      Update or create a System Rescue Diskette that includes currently installed drivers, AUTOEXEC.BAT, 
CONFIG.SYS, and Windows .INI and .GRP files. (This process may install a video driver that is 
incompatible with certain applications or other hardware in system.)

2)      Remove base unit cover.

NOTE: If removing an old video card is not required, skip to Step 4 for installation steps.

3)      Remove the old video card:

a)      Remove the screw from the top notch of the mounting bracket on the card.

b)    Touch the chassis to ground any static and, grasping the video card by its edges, remove the card by 
pulling straight up on it gently but firmly.    Avoid side-to-side movements (circuit boards crack easily).

c)      Place the card in a static-resistant envelope.

d)      If not inserting a replacement card in this slot, replace the rear metal slot cover and secure it in place 
with a screw.

4)      Install new video card:

a)     Remove the video card from its box and from the protective static envelope.

b)      Locate the jumpers or DIP switches on the card and lay the card down on the static envelope with the 
jumpers/DIP switches in view.

c)      Read the video card manual and identify which, if any, settings need to be changed on the card to use 
the COM port and interrupt chosen in Step 1.

d)      Move Jumpers and/or Change DIP Switches, if necessary.

e)    Identify an appropriate size expansion slot for the type of video card to be installed.    Identify the 
required slot type by examining the row of connector pins along the bottom of the card.    An older 
adapter may fit an 8-bit slot.    Most ISA-based video cards require a 16-bit slot while a VESA Local 
Bus card requires an even longer slot.    Choose an appropriate slot by matching the length and gaps in 
this row of connector pins with slots on the motherboard.    Remove the rear metal expansion plate 
cover.

f)      Touch the chassis to ground any static and, grasping the video card by its edges, insert the card bottom 
(part with the gold-striped bars) into the free slot.    Press straight down firmly until card is completely 
seated.    Avoid side-to-side movements when positioning the card (circuit boards crack easily).

g)      Insert the screw, previously removed from the rear metal slot cover, into the top notch of the mounting 
bracket on the card and the screw hole and tighten it securely.

h)      (Optional) If installing 2 video cards for a 2-display setup, attach the VGA pass-through cable to the 



pin connector or edge-style connector along the top of the video card.

5)      Connect the video cable from the display unit to the socket on the back of the video card.    Secure 
connector with attached screws.

6)      Check the display unit for a Analog/TTL switch.    Ensure it is set to 'Analog' (unless it is an old digital 
display).  CAUTION: Setting this switch in the wrong position could damage the display unit.

7)     (Optional) Some high-end video cards and displays ship with BNC connectors (twist on/off) labeled RGB 
(Red, Green, Blue).    If supplied, they should be used because they provide better color separation and 
screen appearance.    2 types are available:

a)      If RGB, connect the red cable to the color input socket marked 'Red' and so on for the others.

b)      If composite (Ext. sync) connect the white or gray cable to 'Horizontal' and the black cable to 
'Vertical'.

8)      Install the video driver and test new configuration:

a)      Ensure no parts or tools remain in chassis.

b)      Replace necessary cables (power, keyboard, mouse, etc.) and plug power cable into surge protector or 
wall outlet.

c)      Power up computer and related peripherals one at a time.    (System should boot normally, assuming 
there are no memory or address conflicts.)

d)      Insert the video driver diskette that came with the video card into floppy drive and enter the 
following:

A:INSTALL (or SETUP (Refer to program instructions))

Press ENTER

e)      Follow installation/setup instructions.

f)      If a specific memory address was set on card in Step 4, exclude this area from Windows management 
by entering the following line in the [386enh] section of SYSTEM.INI and reboot computer:

EMMExclude=xxxx-xxxx

(Where xxxx-xxxx is the video card address (e.g., C800-CFFF).

(This prevents Windows from using the video portion of memory preventing lockups and crashes.)

g)      Test video card, driver installation and display configuration by running installed programs.

9)     If display does not work right or a message about address or interrupt (IRQ) conflicts during use or another 
device (e.g., mouse) fails:

a)      Turn computer system off and check seating of video card and all cable connections.

b)      Reread settings instructions and recheck DIP Switch and Jumper settings.

c)      Ensure proper video driver is selected.

d)      Run a hardware status program (e.g., Microsoft Diagnostics (MSD)) to identify port and interrupt 
(IRQ) assignments.    To run Microsoft Diagnostics, enter the following command at DOS prompt and 
press 'ENTER':

C:\\DOS\\MSD

e)      Identify interrupt (IRQ) assignments using the IRQ Status screen.    <Example: MSD IRQ Status>

CAUTION: Microsoft Diagnostics (MSD) (and some other utilities) report standard interrupt (IRQ) 
assignments for serial ports rather than determining the actual interrupt being used.    If non-standard 
interrupt assignments are suspected, physically check the interrupt settings on the card or device.

f)      See IRQ Conflicts for advice on resolving conflicts.



g)     Contact video card manufacturer for technical support.

h)      If all else fails, reinstall the original video card, reboot from System Recovery Diskette (updated in 
Step 1) and restore the original configuration.10)Replace base unit cover.

11)      Create/update a System Rescue Diskette that includes copies of necessary drivers and the following 
system-specific files:

DOS/Windows: AUTOEXEC.BAT, CONFIG.SYS, Windows .INI and .GRP files.



  

Defective bus mouse; Replace with a working bus 
mouse

CAUTION: The installation, diagnostic or maintenance tasks below should be performed by a qualified 
computer technician.

Solution:

Replace bus mouse:

1)      Run a diagnostic utility (e.g., Microsoft Diagnostics (MSD)) to identify both a free COM port and free 
interrupt.    To run Microsoft Diagnostics, enter MSD at the DOS prompt.

2)     Review and select COM port.

a)     Choose 'COM Ports...' button.

b)      Review list of COM ports to ensure there are no conflicts and identify a free COM port. 

c)     See Serial Port Configuration Standards for information on selecting a COM port.

d)      Select an available COM port.

3)      Review and select interrupt (IRQ).

a)      Choose 'IRQ Status...' button.

b)      Review list of interrupts to ensure there are no conflicts and identify a free interrupt. 

c)     See IRQ Conflicts for information on avoiding IRQ conflicts. CAUTION: Microsoft Diagnostics 
(MSD) (and some other utilities) report standard interrupt (IRQ) assignments for serial ports rather 
than determining the actual interrupt being used.    If non-standard interrupt assignments are 
suspected, physically check the interrupt settings on the card or device.

d)      Select an available interrupt. (TIP: If not using a 2nd printer port and base unit contains few expansion 
cards, interrupt (IRQ) 5 should be available.) NOTE: If removing an expansion board is not required, 
skip to Step 6 for bus mouse card installation steps.

4)      Remove base unit cover.

5)     Remove old bus mouse card:

a)      Remove the screw from the top notch of the mounting bracket on the card.

b)      Touch the chassis to ground any static and, grasping the bus mouse card by its edges, remove the card 
by pulling straight up on it gently but firmly.    Avoid side-to-side movements (circuit boards crack 
easily).

c)      Place the card in a static-resistant envelope.

d)      If not inserting a replacement card in this slot, replace the rear metal slot cover and secure it in place 
with a screw.

6)      Install new bus mouse card:

a)      Remove the bus mouse card from its box and from the protective anti-static envelope.

b)      Locate the jumpers or DIP switches on the card and lay the card down on the static envelope with the 
jumpers/DIP switches in view.



c)     Considering the COM port and IRQ assignments determined in step 1, read the bus mouse card manual 
and identify which, if any, settings need to be changed on the card for this particular computer. NOTE: 
If installing Microsoft Bus Mouse (InPort Adapter), leave port selection switch set to 'Primary Import'.

d)      Move Jumpers and/or Change DIP Switches, if necessary.

e)      Identify a free expansion slot of appropriate size and remove the rear metal slot cover.

f)      Touch the chassis to ground any static and, grasping the bus mouse card by its edges, insert the card 
bottom (part with the gold-striped bars) into the free slot.    Press down firmly until card is completely 
seated.    Avoid side-to-side movements when positioning the card (circuit boards crack easily).

g)      Insert the screw, previously removed from the rear metal slot cover, into the top notch of the mounting 
bracket on the card and the screw hole and tighten it securely.

h)      Orient the serial plug on the end of the mouse cable to the bus mouse card serial socket on the rear of 
the computer and connect it.

i)      Ensure no parts or tools remain in chassis.

j)      Replace necessary cables (power, keyboard, video) and plug in power cable.

k)     Power up computer and related peripherals one at a time.

7) Install mouse driver: 

NOTE: If replacing a mouse with an identical mouse, the following section is optional (however an updated 
mouse driver may be available.

a)      Locate the mouse installation diskette and instructions and insert the diskette in floppy drive.

b)      Enter the following command at the DOS prompt: A:INSTALL or A:SETUP (Depending on 
instructions.)

c)      Follow instructions in the installation program (responding with the port assignment determined in 
step 1).

d)      Respond 'YES' when asked for permission to add information to AUTOEXEC.BAT and/or 
CONFIG.SYS. (This adds the correct driver statement to the file to enable the mouse to run when the 
computer is turned on.)

e)      Press CTRL+ALT+DEL to reboot the computer. (This will load the driver added to AUTOEXEC.BAT 
or CONFIG.SYS into memory and enable mouse to function.)

Do one of the following (8 or 9) if applicable:

8)      If the mouse model differs from the old mouse, update Windows as follows:

a)      Open 'Windows Setup.'

b)      Select 'Options.'

c)      Select 'Change System Settings.'

d)      Select down-arrow next to 'Mouse' to bring down a list of mouse models.

e)      Select appropriate mouse model.

f)      Choose 'OK.'

g)      Choose 'Restart Windows' when asked. (This will reboot computer).

h)      (Optional) Change settings for mouse movement and click rate:

1]     Open 'Main' icon.

2]      Open 'Control Panel.'

3]      Open 'Mouse.'

4]      Adjust the horizontal and vertical slider bars to change the rate at which mouse movement moves 



the cursor on the screen.

5]      Adjust the double-click speed using the slider bar.    Practice setting in the trial box provided.    
Readjust double-click speed if necessary.

6]      Choose 'OK' when done.

8)      If the mouse model differs from the old mouse, update OS/2 as follows:

a)      Open 'OS/2 System.'

b)      Open 'System Setup.'

c)      Open 'Selective install' (this opens the 'System Configuration' panel).

d)     Use the space bar to check the 'Mouse' box.

e)     Choose 'OK.'

f)      Select the mouse type just installed from the list.

g)      Provide the port assignment (determined in step 2 above).

h)      Choose 'OK.'

i)      (Optional) Change settings for mouse movement and click rate:

1]      Open 'OS/2 System.

2]      Open 'System Setup.'

3]      Open 'Mouse' (this opens the 'Timing' page of 'Mouse-Settings' function).

4] Adjust the 'Double-click' slide bar and test the double-click speed in the box labeled 'Test here.'

5] Adjust the 'Tracking speed' slider bar to change the rate at which mouse movement moves the cursor 
on the screen.

6] Double-click in the upper-left-hand corner to close the panel.

10)      Test application software that uses the mouse (drivers and bus mouse card) to ensure proper 
configuration.

11)      Replace base unit cover.

12)      Create/update a System Rescue Diskette that includes copies of necessary drivers and the following 
system-specific files:

DOS/Windows: AUTOEXEC.BAT, CONFIG.SYS, Windows.INI and .GRP files.



  

Defective mouse; Replace with a working mouse

Solution:

Replace the mouse with a working mouse.    Follow the directions for your particular mouse manufacturer.



   

Illegal keys for this software program; Refer to 
software's user manual

Cause: 

Some programs remap (reassign or redefine) certain keyboard keys to suit their own purposes.

Solution: 

Exit program.    Read application user manual to learn new keyboard mapping.



 



 



 



 



 



 



 



 



 



 





 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 





 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 










